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READ CAREFULLY BEFORE USING!
CANON SOFTWARE LICENSE AGREEMENT
IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-

ROM IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE 

TERMS OF THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]). 

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO 

NOT USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN 

THIS BOX (COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 

30 DAYS FROM THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A 

REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and 

conditions of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a 

single computer. You may physically transfer the SOFTWARE from one computer to 

another provided that the SOFTWARE is used on only one computer at a time. You shall not 

install or use the SOFTWARE on a network, multiple CPU, multiple site arrangement, or any 

other hardware configuration where the SOFTWARE is accessible to more than one CPU or 

to more than one user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE 

USE, TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING 

LANGUAGE, ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN 

WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, 

or copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your 

computer and retain the original for back-up purposes. Any other copying of the 

SOFTWARE is a violation of this Agreement. You must reproduce and include the copyright 

notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support 

for use of the SOFTWARE. No updates, fixes or support will be made available for the 

SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose, 

maintain and match the hardware and software components of your computer system. Thus 

Canon does not guarantee uninterrupted service or correction of errors or that the functions 

or performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS 

LICENSED ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-

ROM storing the SOFTWARE is warranted only against defective material under normal use 

for a period of ninety (90) days after purchase from an authorized Canon dealer as 

evidenced by your sales receipt. Your sole remedy for a defective CD-ROM shall be 

replacement of the same without charge when returned by you at your expense to your 

point of purchase and proven to be defective upon inspection. The replacement CD-ROM 

will be warranted for the remainder of the original ninety (90) day warranty period of the 

defective CD-ROM. The limited warranty does not apply if the failure of the CD-ROM 

resulted from accident, abuse or misapplication of the SOFTWARE and shall not extend to 

anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S 

SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS 

OR IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A 

PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.
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NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 

IS LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT 

LIMITATION, DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE 

INCLUDING LOSS OF PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED 

OR ARISING OUT OF THE SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS 

SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT 

BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE 

THEREOF INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect 

until expiration of all copyright interests in the SOFTWARE unless earlier terminated. You 

may terminate this Agreement by destroying the SOFTWARE. This Agreement will also 

terminate without notice to you if you fail to comply with any of the terms of this Agreement 

and you must then promptly return the SOFTWARE. In addition, Canon may enforce its 

other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with 

restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either 

subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at 

DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer 

Software Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be 

illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void 

with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this 

Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the 

Software in the United States of America shall be governed and construed in all respects in 

accordance with the laws and regulations of the State of New York, without reference to 

choice of law principles. The terms of this Agreement as it relates to purchases of the 

Software in Canada shall be governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the 

SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use 

of the SOFTWARE is subject to the United States, Canada and other applicable copyright 

and trademark laws and nothing in this Agreement constitutes a waiver of the rights of 

Canon, its affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in 

any images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU 

HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY 

ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE 

COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND 

CANON CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL 

PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER 

COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER 

HEREOF. NO AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS 

SIGNED BY A DULY AUTHORIZED OFFICER OF CANON.
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Manual Organization, How to Read the Manual and the Conventions Used
 This manual consists of a chapter for Windows followed by a chapter for Macintosh.

 In this manual, Windows XP Professional/Home Edition is referred to as Windows XP, Windows 

Millennium Edition is referred to as Windows Me, Windows 2000 Professional is referred to as 

Windows 2000, and Windows 98 Second Edition is referred to as Windows 98 SE.

 Where explanations are common to all operating systems, the screens used in the 

examples are from Windows XP for Windows and from Mac OS X (10.2) for Macintosh.

 This manual describes operating methods for the EOS 20D and uses the EOS 20D screens 

in examples. Supplementary information has been given where necessary about functions 

that are unique to each camera.

 In this document, square brackets [ ] are used to indicate items such as button names and 

icon names that appear on the computer screen.

 Numbers in parentheses in this document indicate reference pages.

 Descriptions of camera operations assume that the reader is familiar with the information in 

the camera’s Instruction Manual.

 For the restrictions that apply to the software products, refer also to the Readme files for the 

respective products.

 In order to transfer images from the EOS Viewer Utility, you will need retouching (image 

editing) software. In order to start the TWAIN Driver, you will need a TWAIN Driver-

compatible application. Explanations for transferring images from the EOS Viewer Utility 

described in these instructions and the explanations for TWAIN Driver-compatible 

applications all use examples from Adobe Photoshop 7.0.

 The explanations given below describe the type of content indicated by the respective icons.

 : Marks information that should be read before use to prevent problems that would 

interfere with the functioning of software and computer.

 : Marks additional information that you will find helpful.

Please read the safety precautions carefully before using this product. Ensure that you use the 

product correctly according to the procedures described in these instructions.

The following safety precautions are intended to instruct you in the safe and correct operation 

of the product and its accessories to prevent injuries or damage to yourself, other persons and 

property. Please read and ensure that you understand them before you proceed to the other 

sections of these instructions.

 Warning

Do not play the supplied CD-ROM(s) in any CD-ROM Player that does not support data CD-ROMs. The 

extremely loud sound that may result from playing the CD-ROM(s) in an audio CD player (music player) 

could damage the speakers. It is also possible to suffer hearing losses from listening with headphones to 

the loud sounds of a data CD-ROM played on a music CD player.

Safety Precautions
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Software
This section briefly describes the main functions of the software provided on the bundled CD-

ROM.

 EOS DIGITAL Solution Disk

 The PhotoStitch creates composite images such as panorama shots by merging multiple 

images.

 The WIA Driver or TWAIN Driver controls the communication between the camera and the 

software. You must install the WIA Driver for Windows XP or Me, and install the TWAIN 

Driver for Windows 2000 or 98 SE.

 Also used for downloading JPEG images to your computer if you use the WIA Driver alone, 

or use the TWAIN Driver with a TWAIN Driver-compatible application.

 Dedicated software for an EOS DIGITAL 

camera to be used for downloading and 

displaying images, and processing RAW 

images.

 Can be used for downloading images 

saved on the memory card in the camera 

to your computer, displaying single-

frame or thumbnail images, checking 

shooting information or histograms.

 Capable of rotating, protecting, and 

saving images, printing image indexes, 

and transferring images to the 

retouching software.

 Can be used for displaying RAW images and specifying various processing parameters.

 Supports the color management system.

 Supports the color space of sRGB and Adobe RGB.

 Enables you to control the camera from your computer to shoot single-frame images or 

images using the timer or interval timer. Also, allows you to download images directly to 

your computer.

* The EOS Capture is compatible with the EOS 20D only.

* The EOS Capture for Macintosh is only compatible with Mac OS X.

EOS Viewer Utility       

EOS Capture       

PhotoStitch       

WIA Driver/TWAIN Driver      
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 In addition, you can use the WIA Driver or TWAIN Driver (W-63) to quickly and easily 

download JPEG images from your camera. You can also use the PhotoStitch to merge 

multiple images to create a panorama shot easily.

*1 With the EOS Viewer Utility for Mac OS 9, you cannot download images by connecting the 

camera and your computer. Download images to your computer by either using the EOS 

Viewer Utility for Mac OS X or by using a third-party card reader.

*2 Remote shooting in the EOS Eapture is only available with the EOS 20D. 

You cannot do remote shooting in the EOS Capture on Mac OS 9.

Trademark Acknowledgments

 Canon and EOS are trademarks of Canon Inc.

 Adobe and Photoshop are registered trademarks or trademarks of Adobe Systems 

Incorporated in the United States and/or other countries.

 IBM is a registered trademark of International Business Machines Corporation.

 Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation 

in the United States and/or other countries.

 iBook, iMac and QuickTime are trademarks of Apple Computer Inc.

 Macintosh, PowerBook and Power Macintosh are trademarks of Apple Computer Inc., 

registered in the United States and other countries.

 Other names and products not mentioned above may be registered trademarks or 

trademarks of their respective companies.

Operation Flow

Install the software (W-4, M-4)

Start up the EOS Viewer Utility (W-14, M-14)

Connect the camera to your computer (W-9, M-9)

To edit/display the images

Download the images to your 

computer*  (W-18, M-18)

Edit/Display the images 
(W-22 to 40, M-22 to 40)

For remote shooting

Start up the EOS Capture*
(W-54, M-54)

Shoot remotely and download the 
images (W-56, M-56)

2
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1 Installing the Software .............................................................................. W-3

Describes how to install the bundled software.

2 Preparation for Downloading Images ...................................................... W-7

Explains how to set up communication mode, how to connect the camera or a card reader 

(third-party product) to your computer and complete the installation.

3 Working with Images in the EOS Viewer Utility .................................... W-13

Explains how to use the EOS Viewer Utility to download images to your computer, edit 

and save images, and transfer the downloaded images to the retouching software.

4 Remote Shooting in the EOS Capture ................................................... W-53

Describes how to use the EOS Capture for taking shots and specifying the camera 

settings remotely from your computer.

 Remote shooting in the EOS Capture is only available with the EOS 20D.

5 Downloading JPEG Images with the Driver .......................................... W-63

Describes how to download JPEG images using the WIA Drivers for Windows XP or 

Windows Me, and the TWAIN Drivers for Windows 2000 or Windows 98 SE.

6 Troubleshooting and Uninstallation ...................................................... W-69

Provides a troubleshooting and describes the software uninstallation procedures.

Index ..........................................................................................................................W-76

Where explanations are common to all operating systems, the screens used in the examples 

are from Windows XP.

W
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System Requirements
The software bundled with this product runs on the systems described below.

 Depending on your computer system, this software may not run correctly on Windows 98. 

Use the Windows 98 SE operating system or later.

 A CD-ROM drive is required for installation.

* Only the EOS 20D is compatible with USB 2.0 Hi-Speed.

OS
Windows XP (Home Edition/Professional), Windows Me, 

Windows 2000, Windows 98 SE

Computer

PC with one of the above OS preinstalled and a USB port as a 

standard feature

* Upgraded machines not supported.

CPU
Windows XP: 300 MHz Pentium or better

Windows Me, 2000, 98 SE: 150 MHz Pentium or better

RAM
Windows XP: Minimum 256 MB

Windows Me, 2000, 98 SE: Minimum 128 MB

Interface USB 1.1 to 2.0 Hi-Speed*

Hard disk space

EOS Viewer Utility: 100 MB or more

EOS Capture: 300 MB or more

WIA Driver: 25 MB or more

TWAIN Driver: 25 MB or more

PhotoStitch: 40 MB or more

Display
Screen resolution: 1024 by 768 pixels or more

Color quality: Medium (16 bit) or more
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Installing the 

Software

This chapter describes how to install the bundled software.

If you were unable to successfully install the software using the procedure given in 

this manual, see “Troubleshooting” (W-70).

Installing the Software ............................................................................ W-4

Correct Installation Procedure .............................................................. W-4
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Installing the Software
 Check that your computer complies with the system requirements for the software (W-2) as 

you follow the installation procedure.

 Always install the software as described in the procedures below.

1 Start up your computer (step 1).

2 Install the software (steps 2 through 9).

3 Remove the CD (step 10).

4 Set the communication mode (W-8).

5 Connect the camera to your computer and complete the installation (W-9).

 Never connect the camera to your computer before you install the software. The 

software will not be installed correctly. You must connect the camera to your computer 

after removing the CD.

 If you connected the camera to your computer before installing the software, see 

“Troubleshooting” (W-73).

1 Start up your computer.

 Exit any programs that are running.

2 Insert the CD (EOS DIGITAL Solution Disk).

 The Installer panel appears.

3 Click the [Install] button.

 The [Preparing to Install] window 

appears and after a brief wait, the 

[Welcome to the InstallShield 

Wizard for Solution Disk] window 

appears.

If the dialog box that prompts you to restart your computer appears, restart your computer. 

After the computer restarts, the software installation process restarts automatically.

Correct Installation Procedure
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4 Click the [Next] button.

5 Select [Easy Installation] and click the [Next] button.

6 Check the details of the License Agreement and then click the 

[Yes] button.

7 Check the software and the folder in which the software will be 

installed, and then click the [Next] button.

 Installation begins. It will be 

complete in approximately 2 to 3 

minutes.
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8 Click the [Finish] button.

9 Click the [Exit] button.

10Remove the CD.

 Continue by setting up 

communication mode and 

connecting the camera and 

computer in Chapter 2 to complete 

installation.

If you were unable to successfully install the software using the procedure given in this 

manual, see “Troubleshooting” (W-70).
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Preparation for 

Downloading Images 

This chapter explains how to set up communication mode, how to connect 

the camera or a card reader (third-party product) to your computer and 

complete the installation.

If you were unable to successfully install the software using the procedure given in 

this manual, see “Troubleshooting” (W-70).

Setting the Communication Mode.......................................................... W-8

Connecting the Camera to Your Computer........................................... W-9

Connecting the Camera to Your Computer for the First Time .............. W-9

Connecting the Camera to Your Computer the Second Time or Later ... W-10

Using Your Card Reader ....................................................................... W-11

Downloading JPEG Images Using the PTP Function in Windows XP .... W-12
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Setting the Communication Mode
To communicate with the camera using the software on the Solution Disk, set the camera’s 

communication mode to [Normal].

 The settings on this page are only necessary for the EOS 20D, EOS 10D and EOS 

DIGITAL REBEL/300D DIGITAL.

 With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details on 

changing, see the Canon website.

About the PTP Setting
The PTP function is only available to Windows XP users. This function provides a simple 

means of downloading JPEG images to your computer. To use this function, set 

[Communication] to [PTP] in step 2 above.

 For more information on using the PTP function to download JPEG images, see 

“Downloading JPEG Images Using the PTP Function in Windows XP” (W-12).

1 Check that the camera is not connected to the computer and then 

set the camera’s power switch to <ON>.

2 Set the camera’s communication mode to [Normal].

 Set [Communication] in menu to 

[Normal].

 With the EOS DIGITAL REBEL/

300D DIGITAL, set 

[Communication] in menu option 

< > to [Normal].

3 Press the < > button to switch the LCD monitor display off 

and then set the camera’s power switch to <OFF>.

 If you set the communication mode to [PTP], the Solution Disk software cannot 

communicate with the camera. When you are using the software, always set the 

communication mode to [Normal].

 When setting the communication mode, always ensure that the camera is not 

connected to the computer beforehand. Setting the communication mode while the 

camera is connected to the computer will cause camera and software malfunctions.
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Connecting the Camera to Your Computer
Before downloading images to your computer or specifying the camera settings, you must 

connect the camera to your computer with the dedicated USB cable. 

You can connect the camera while your computer is running.

When you connect the camera to your computer for the first time to complete the installation, 

follow the procedure below right after performing “Installing the Software” (W-4) and “Setting 

the Communication Mode” (W-8).

1 Plug the dedicated cable into the computer.

 Plug the cable into the USB port.

 Refer to the computer User’s 

Manual for information on the 

terminal areas.

2 Plug the dedicated cable into your camera.

 Open the cover and connect the 

cable to the < > terminal 

with the [ ] icon facing the front 

of the camera.

 With the EOS D60 and EOS D30, 

connect by aligning the <�> mark 

on the plug with the <�> mark on 

the < > terminal.

3 Set the camera’s power switch to <ON>.

 When the pop-up menu appears and then disappears automatically, the installation is 

complete.

Connecting the Camera to Your Computer 
for the First Time
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When you connect the camera to your computer the second time or later, follow the same 

procedure, set the camera’s power switch to <ON>, and then proceed to Chapter 3.

 For Windows 2000, Me, 98 SE, a dialog box such as [Found New Hardware] or 

[Building driver information database] may appear. If this is the case, installation will 

be completed when the dialog box disappears.

 When the installation is complete, the camera is ready to communicate with your 

computer. Proceed to Chapter 3 continuously.

 Do not set the camera’s power switch to <OFF> until the pop-up menu and dialog 

boxes automatically disappear.

 If the dialog box that prompts you to restart your computer appears, restart your 

computer without fail.

 If you were unable to successfully install the software using the procedure given in 

this manual, see “Troubleshooting” (W-70).

The pop-up menu and dialog boxes shown in step 3 do not appear when you connect the 

camera to your computer the second time or later.

 Never perform the following operations while the software installed from the Solution Disk is 

running after connecting the camera to the computer as a communications error may occur.

• Set the camera’s power switch to <OFF>.

• Open the CF card slot cover.

• Disconnect the dedicated cable, remove the battery, and then remove the AC 

adapter kit (optional) or DC coupler.

• Disconnect the AC adapter’s or DC coupler’s plug or power cord.

Before you perform the operations above, be sure to exit all the software.

 You cannot communicate with the camera when you are displaying images through 

the camera’s LCD monitor. Always connect the camera and your computer after 

turning off the display in the LCD monitor.

 While the camera and your computer are communicating, the camera’s LCD panel 

may blink.

 Use only the dedicated cable.

 Push the plug firmly all the way into the socket. Loose connections can cause faults 

or malfunctions.

 Do not connect the camera to your computer via a hub. If you do so, the camera may 

not operate correctly.

 If you connect multiple USB devices (excluding mouse and keyboard) to your 

computer the camera may not operate correctly. Disconnect other USB devices from 

your computer and connect only the camera.

 Operation of the Auto power off function will automatically switch the camera off, 

disabling to communicate with your computer. Set the Auto power off function to 

[OFF] in advance. (Refer to “Menu Operations” in the camera’s Instruction Manual.)

Connecting the Camera to Your Computer 
the Second Time or Later
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Users with a third-party card reader can download images directly from a memory card to the 

computer.

 Do not connect more than one camera to the same computer. The connections may 

not operate correctly.

 When unplugging the dedicated cable, be sure to grip the sides of the plug as you pull 

it out.

* If you are using the EOS D60 or EOS D30, pull the plug while pressing the PUSH 

button on it.

 If you do not perform any operation while the camera and computer are connected, a 

confirmation message appears on the computer screen asking whether you wish to 

continue communicating with the camera for some computer systems. If you do not 

perform any operation even after this message appears, the communication with the 

camera is terminated. To re-establish the communication, press the shutter button 

down halfway or set the camera’s power switch to <OFF> and then back to <ON>.

 Do not put your computer to sleep while it is connected to the camera. 

If your computer goes into the sleep mode, never disconnect the dedicated cable 

while your computer is still in the sleep mode. Always wake your computer up while it 

is connected to the camera. On some types of computer, disconnecting the dedicated 

cable while your computer is in sleep mode could prevent the computer from waking 

up correctly. Refer to the computer User’s Manual for more information on sleep 

mode.

When you connect the camera and your computer, it is recommended that you use an 

AC adapter kit (optional) with the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D 

DIGITAL, and the DC coupler supplied with the EOS D60 and EOS D30.

1 Remove the memory card from the camera.

2 Load the card into the card reader.

 Proceed to Chapter 3 

continuously.

For information on connecting the card reader to your computer, refer to the card reader 

User’s Manual.

Using Your Card Reader
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Downloading JPEG Images Using the PTP Function in Windows XP
Windows XP users can use the PTP (Picture Transfer Protocol) function. The PTP function 

allows you to download JPEG images saved on a memory card in the camera to your computer 

without having to start the software provided on the Solution Disk.

 This function is available with the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D 

DIGITAL only.

 With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details on 

changing, see the Canon website.

1 Set the camera’s communication mode to [PTP] (W-8).

 Set [Communication] in menu to 

[PTP].

 With the EOS DIGITAL REBEL/

300D DIGITAL, set 

[Communication] in menu option 

< > to [PTP].

 Press the < > button to 

clear the LCD monitor display.

 When you have finished, set the 

camera’s power switch to <OFF>.

2 Connect the camera to the computer and set the camera’s power 

switch to <ON> (W-9).

 The [Scanner and Camera 

Wizard] dialog box appears.

3 Download images as directed in the [Scanner and Camera Wizard] 

dialog box.

 For the procedure for downloading JPEG images using the [Scanner and Camera 

Wizard], refer to step 3 onwards in “Downloading with [Scanner and Camera Wizard]” 

(W-64).

Refer to the separate “Notes on the PTP Function” for details when the downloaded 

image does not display correctly or the image cannot be downloaded.
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Working with Images in 

the EOS Viewer Utility

This chapter explains how to use the EOS Viewer Utility to download images 

to your computer, edit and save images, and transfer the downloaded 

images to the retouching software.

For more information on the restrictions of the EOS Viewer Utility, refer also to the 

source listed below.

Readme: Click the [Start] button � select [All Programs] ([Programs] in other 

versions of Windows) � [Canon Utilities] � [EOSViewerUtility xx] (“xx” is 

the version) � [EOSViewerUtility Readme].

Starting the EOS Viewer Utility ... W-14

Downloading Images ................... W-18

Handling the Folders.................... W-20

Memory Card Folder Structure and File 

Names ........................................ W-20

Registering Frequent Use Folder ...W-21

Selecting the Image Display Mode ....W-22

Main Window (Thumbnail Display) ....W-22

Preview Window Display ............ W-22

Selecting the Display Size .......... W-24

Checking the AF Point................ W-24

Selecting Images .......................... W-25

Selecting Images in the Main Window .. W-25

Selecting Images in the Preview 

Window....................................... W-25

Attaching Check Marks to Images .....W-26

Selecting Images by Condition ... W-26

Bringing/Sending the Main Window to 

the Front/Back of Window Stack...W-27

Equalizing the Display Sizes in the 

Preview Window ......................... W-27

Editing Images.............................. W-28

Protecting Images....................... W-28

Rotating Images ......................... W-28

Deleting Images ......................... W-29

Checking the Image Information and 

Entering Comments.................... W-29

Printing Images ............................ W-30

Editing Raw Images ..................... W-31

Processing RAW Images ........... W-31

Specifying the Processing Parameters ..W-32

Adjusting the Brightness (Digital 

Exposure Compensation)........... W-33

Adjusting the White Balance ...... W-34

Selecting the Contrast ................ W-37

Adjusting the Color ..................... W-38

Specifying the Color Space ........ W-40

Selecting the Sharpness ............ W-40

Saving Images .............................. W-41

Extracting JPEG Images from RAW 

Images........................................ W-43

Transferring Images to Retouching 

Software ........................................ W-44

Specifying the Preferences ......... W-46

Setting the IPTC Information....... W-47

Specifying the Camera Settings ...W-50

Merging Images with the PhotoStitch ...W-52
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Starting the EOS Viewer Utility

1 Connect the camera to your computer (W-9).

 The dialog box on which the 

camera model is displayed 

appears.

 Your camera model is displayed in 

EOS XXX.

 For Windows Me, the [Scanner 

and Camera Wizard] dialog box 

appears.

 Click the [Cancel] button to close 

the open window.

2 Click the [Start] button � select [All Programs] ([Programs] in 

other versions of Windows) � [Canon Utilities] �

[EOSViewerUtility xx] � [EOSViewerUtility].

 The main window appears.

 You can also start the EOS Viewer Utility by double-clicking the [EOSViewerUtility] 

icon on the desktop.

 The EOS Viewer Utility version information is displayed in xx.
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Main window

 To exit the EOS Viewer Utility, select the [File] menu � [Exit].

Main window tool bar Menu bar

Displays the [File], [Edit], [View], 
[Option], [Window], [Help] menus.

Histogram

Shows the distribution of the brightness of an 
image. Selecting the tab switches the histogram 
display values between Brightness and RGB.

Path display

Displays the folder path selected 
in the Folder Tree Area.

Image display area Comment input box (W-29)

Bookmark area (W-21) 
Detailed Information 
display area (W-29)

Folder Tree Area (W-18) RGB value display

When you move the cursor over an image, the 
coordinates of the cursor position and its RGB 
values (8-bit conversion) are shown here.

Image information display area

Displays basic shot information.

Status bar
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Main window tool bar

Folder Tree button

Shows/hides the Folder Tree Area.

Display Size 
list box (W-24)

Rotate right 90 degrees button (W-28)

Remove Check Mark button (W-26)

Remove protect button (W-28)

Transfer images button (W-44)

Protect button (W-28)

Erase images button (W-29)

Select images button 
(W-26)

Thumbnail Frames button
Shows/hides the information 
display frame of thumbnail images.

Add Check Mark button (W-26)

Rotate left 90 degrees button (W-28)

EOS Capture 
button (W-54)

IPTC information button 
(W-47)

Play sound button

*This button does not work with 
the camera you are using.

Window button (W-27)

Save File button 
(W-41)

Show/Hide Image Information button

Shows/hides the histogram, image information display area, 
Detailed Information display area, and comment input box.
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RAW adjustment tool palette

 When you select a RAW image, the name of the camera on which the selected RAW image 

was taken and its settable processing parameters are displayed.
*1 Not displayed with the EOS 10D and EOS DIGITAL REBEL/300D DIGITAL RAW images.
*2 Not displayed with the EOS D60 RAW images.
*3 Not displayed with the EOS D30 RAW images.

 Where you have selected a JPEG image or where you have selected a TIFF or JPEG 

image converted from a RAW image with the EOS Viewer Utility, nothing is displayed 

on the RAW adjustment tool palette and the image cannot be edited.

 Where you have selected a RAW image saved on the memory card inside the 

camera, nothing is displayed on the RAW adjustment tool palette and the image 

cannot be edited. Work with the images saved on your computer from the memory 

card.

 The settings used when shots were taken are displayed in italic or bold type in the list box.

 If the RAW adjustment tool palette is hidden, select the [View] menu � [Tool palette] to 

show it.

Digital Exposure Compensation 

slider (W-33)*3

Color temperature input box 

(W-35)*2, 3

Click White Balance button (W-36)

Sharpness list box (W-40)

Displays the name of the camera 
on which the selected RAW 
images were taken.

Contrast list box (W-37)

Color Saturation list box (W-38)

Color Tone list box (W-38)*3

Color Space list box (W-40)*2, 3

Update button (W-32)

Reset to Shot Settings button 
(W-32)

White Balance Compensation 

slider (W-37)*1, 2, 3

Standard radio button 

(W-38)*1, 2, 3

Monochrome radio button 

(W-38)*1, 2, 3

White Balance list box 
(W-34, W-35)

Filter Effect list box (W-39) *1, 2, 3

Toning Effect list box (W-39) *1, 2, 3

Preview checkbox (W-32)
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Downloading Images
The procedure below describes how to download (copy) the images saved on a memory card 

in the camera to your computer, and display them on the main window. You can download 

images in the Folder Tree Area.

1 Create a folder to which images will be downloaded.

 From the menu that is displayed 

by right-clicking on the destination 

folder, select [New folder] to 

create a folder and enter a name 

for the folder. (The [Photo] folder is 

created in the [My Pictures] folder 

here as an example.)

2 Display a folder to be copied.

 Double-click the camera icon �

the [1] folder � the [DCIM] folder.

 The [xxxCANON] folder is 

displayed. (“xxx” represents a 

number 100 to 999.)

3 Copy the folder to the hard disk.

 Drag and drop the [xxxCANON] 

folder to the destination folder.

 The [xxxCANON] folder is saved 

on your computer.
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Supported Image Formats
The images below can be displayed with the EOS Viewer Utility.

* Includes TIFF and JPEG images converted from RAW images and saved with the EOS 

Viewer Utility.

4 Click the copied folder.

 The images in the folder are 

displayed.

 Before disconnecting the camera 

from your computer, exit the EOS 

Viewer Utility, set the camera’s 

power switch to <OFF>, and then 

disconnect the dedicated cable.

 You cannot display images in the preview window (W-22) or edit RAW images (W-31) 

saved on a memory card in the camera directly. Work with the images saved on your 

computer from the memory card.

 For displaying images saved in a third-party card reader, follow the same procedure 

to download the target folder to your computer.

Image Format File Extension

RAW images taken with the EOS-1D Mark II and the EOS 20D .CR2

RAW images taken with the EOS-1Ds and the EOS-1D .TIF

RAW images taken with the EOS 10D, DIGITAL REBEL/300D DIGITAL, 

D60 and D30
.CRW

JPEG images conforming with the Exif 2.2, 2.21 standard* .JPG/.JPEG

TIFF images conforming with the Exif standard* .TIF/.TIFF

 Images that cannot be displayed appear as a question mark [?].

 The images that are processed on your computer after being shot or the images 

whose file name is changed may not be displayed properly.

 You cannot use the camera while displaying images on the camera.

 By setting [Auto rotate] setting to <ON> for the camera with this function, images shot 

in a vertical position are automatically displayed vertically.

 If the selected folder contains a large number of images, there may be a short delay 

before the images appear.
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Handling the Folders
You can handle the folder on the menu that appears by right-clicking the folder.

 The “xxx” in the folder names represent a number between 100 to 999.

 The “YYYY” in the file names represent a number between 0001 to 9999.

Right-click on the folder and select an option from the menu that 

appears.

You can drag and drop folders from the Folder Tree Area to the other folders.

The file name of images shot with the EOS 20D is “_MG_” (the first character is an 

underscore) when Adobe RGB is set.

Opens the selected folder.

Creates a new folder. Note that you 
cannot create a new folder in the 
memory card in the camera.

Allows you to change the folder name.

Memory Card Folder Structure and File Names

xxxCANON

IMG_YYYY.JPG: JPEG image

CRW_YYYY.CRW: EOS 10D, EOS DIGITAL REBEL/
300D DIGITAL, EOS D60, EOS 
D30 RAW images

CRW_YYYY.THM: Image for displaying the camera’s 
index

DCIM

1

CANONMSC

MISC

The folder that holds the image control files 
in the DCIM folder.

The folder created when DPOF settings are set.
It holds the DPOF settings files.

IMG_YYYY.CR2: EOS 20D RAW image
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You can register frequent use folders as bookmark folders.

1 Display a folder to be registered (W-18).

2 Register a folder as a bookmark folder.

 Drag and drop the folder to be 

registered as shown on the right.

 The folder icon appears in the 

Bookmark area when it is 

registered.

 To delete the registered folder, 

right-click the folder and select 

[Delete] from the menu that 

appears.

 You can also reorder the folders in the Bookmark area by dragging and dropping 

them.

 When you delete the registered folder, it just disappears from the Bookmark area. 

The actual data of the folder and the images in that folder will not be deleted.

Registering Frequent Use Folder
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Selecting the Image Display Mode
You can select the display size and method of images.  

Various information can be displayed with images.

Double-clicking an image displayed on the main window can enlarge the image. 

When you change the processing parameters of RAW images, use this window.

 The preview window can display a maximum of six previews.

 A low resolution image is displayed first in the preview window, and then it changes to a high 

resolution image.

Preview window

Main Window (Thumbnail Display)

Digital exposure 
compensation value (W-33)

Protect mark (W-28)
This mark is displayed 
on protected images.

File name or shooting date/time

The items selected in the [Image 
Lower Display Item] list box in the 
[Preferences] dialog box (W-46) are 
displayed.

Check mark (W-26)
This mark is displayed on images for 
which a check mark was attached.

Display number 
Numbers are assigned 
sequentially to the displayed 
images starting with the first 
image.

Recording quality

The [RAW] and [RAW+JPEG] 
symbols are displayed for RAW 
and RAW+JPEG images 
respectively. No symbol is 
displayed for JPEG images.
*Only images taken with the 
EOS 20D in RAW+JPEG format 
display the [RAW+JPEG] 
symbol.

Preview Window Display

Preview tool bar
RAW adjustment tool palette
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Preview tool bar

You cannot display images in the preview window or edit RAW images (W-31) saved on 

a memory card in the camera directly. Work with the images saved on your computer 

from the memory card.

 For some images, it may take some time to change to the high resolution image.

 You can set the image displayed in the preview window to RAW image or the 

simultaneously recorded JPEG image (W-46).

Show Next Image button (W-25)

Rotate left 90 degrees button (W-28) Remove Check Mark button (W-26)

Erase images button (W-29)

Save File button 
(W-41)

Add Check Mark button (W-26)

Rotate right 90 degrees button (W-28)

Show Previous 
Image button (W-25)

Show/Hide Image Information button

Show/hides the histogram, image information 
display area, Detailed Information display area, 
and comment input box.

AF point button (W-24)
*Only compatible with EOS 
20D, EOS 10D and EOS 
DIGITAL REBEL/300D 
DIGITAL images.

IPTC information button (W-47)

Play sound button
*This button does not work with the camera you are using.

Window button (W-27)

JPEG preview button

Changes the image displayed in the 
preview window to a RAW or JPEG 
image.
* Only compatible with EOS 20D 

RAW+JPEG images and EOS 10D, 
EOS DIGITAL REBEL/300D DIGITAL 
and EOS D60 RAW images.

Display Size list box (W-24)

Protect button (W-28)

Remove protect button (W-28)

Transfer images 
button (W-44)
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The AF point used when the shot was taken can be displayed.

 This function is only available with images of the EOS 20D, EOS 10D and EOS 

DIGITAL REBEL/300D DIGITAL.

Select a display size from the list box.

 In the main window, the available 

image sizes are [Small] (64  42 

pixels), [Medium] (100  66 

pixels), and [Large] (160  106 

pixels).

 In the preview window, the 

available image sizes are [Fit to 

window] and [100%].

 When you select [100%], you can 

change the display position by 

dragging the image.

1 Display the image in the preview window (W-22).

2 Click the [AF point] button.

 The AF point is displayed.

 Clicking the button again hides the 

AF point.

When the shot was taken with automatic AF point selection, multiple active AF points 

might be displayed.

Selecting the Display Size

Main window

Preview window

Checking the AF Point
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Selecting Images

Click the target image.

 The frame around the selected 

image is colored.

 To select multiple images, hold 

down the <Ctrl> key and click the 

images.

 To select sequential images, click 

the first image and then hold down 

the <Shift> key and click the last 

image.

Alternatively, you can use the arrow keys (����) on the keyboard to select images. 

Click the target image.

 The selected image is displayed 

on the top window.

 When only one preview window is 

displayed, you can click the [Show 

Previous Image] button or the 

[Show Next Image] button to 

select the image to be displayed.

Selecting Images in the Main Window

Selecting Images in the Preview Window
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You can attach a check mark to the RAW image, allowing you to select images more easily.

This feature allows you to select multiple images in a single operation using conditions.

Click the [Add Check Mark] button.

 When the check mark is placed, 

the [ ] icon appears in the frame 

of the image.

 Clicking the [Remove Check Mark] 

button removes the [ ] icon from 

the frame of the image, and 

erases the check mark.

You cannot attach the check mark for any images other than RAW images.

 When multiple RAW images are selected, the check mark is attached to all the 

selected RAW images.

 Alternatively, you can perform the same operation using the menu that appears by 

right-clicking.

Click the [Select images] button and select the condition from the 

menu that appears.

 Only images that meet the 

condition are selected.

Attaching Check Marks to Images

Selecting Images by Condition
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You can set all the preview windows to the same size.

Select [Move main window to front] or [Move main window to 

back] from the menu that appears by clicking the [Window] 

button.

 The main window is brought/sent 

to the front/back of window stack.

1 Select the image whose size is the desired size (W-25).

2 Click [Standardize preview window size] from the menu that 

appears by clicking the [Window] button.

 All the displayed preview windows 

are set to the same size as the 

selected image.

Bringing/Sending the Main Window to the 
Front/Back of Window Stack

Equalizing the Display Sizes in the 
Preview Window
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Editing Images
You can edit all the images that can be displayed in the EOS Viewer Utility.

You can protect important images to prevent them from being accidentally deleted.

You can rotate a selected image by 90-degree increments left or right.

When multiple images are selected, the edits are applied to all the selected images.

Click the [Protect] button.

 When the image is protected, the  

[ ] icon appears in the frame of 

the image.

 Clicking the [Remove protect] 

button removes the [ ] icon from 

the frame of the image, and clears 

the protection.

 The [ ] is automatically displayed for images that were protected on the camera.

 Protection only prevents images from being deleted. Other types of image operations 

can still be performed for protected images.

 Alternatively, you can perform the same operation using the menu that appears by 

right-clicking.

Click the [Rotate right 90 degrees] or [Rotate left 90 degrees] 

button.

 The image rotates 90 degrees in 

the selected direction.

 By setting [Auto rotate] setting to <ON> for the camera with this function, images shot 

in a vertical position are automatically displayed vertically.

 If a rotated image is displayed in another application, the image may not appear 

rotated.

 Alternatively, you can perform the same operation using the menu that appears by 

right-clicking.

Protecting Images

Rotating Images
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You can move unnecessary images to the Recycle Bin on your computer and delete them.

You can check the information recorded with images and input comments.

1 Click the [Erase images] button.

 The images are moved to the 

Recycle Bin.

2 Select [Empty Recycle Bin] from the menu that appears by right-

clicking [Recycle Bin] on the desktop.

 The images are deleted.

 Images that you deleted by selecting [Empty Recycle Bin] in step 2 cannot be 

restored. Check carefully before deleting images.

 Protect important images (W-28) to prevent them from being accidentally deleted.

Alternatively, you can perform the same operation using the menu that appears by right-

clicking.

Detailed Information display area

 The shooting information is displayed. 
The number of items displayed differs depending on the camera settings.

 You can copy the information as text data and paste it into another application.
 Clicking the [▼] button can hide the Detailed Information display area.

You cannot insert a hard return in the comment input box.

When multiple images are selected, the information from the image selected last is 

displayed.

Deleting Images

Checking the Image Information and Entering Comments

Comment input box

You can use this box to type in a comment up to 120 characters long.
Type in your comment and press the <Enter> key.
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Printing Images
You can use the EOS Viewer Utility to print images in index format.

1 Select images to be printed in index format (W-25).

2 Select the [File] menu � [Print Index].

 Printing begins.

If you wish to specify the printer settings, select the [File] menu � [Page Setup].
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Editing Raw Images
You can specify the processing parameters for RAW images so that the RAW images are 

optimized for their intended purpose.

RAW images are processed based on the settings specified on the camera (including the 

processing parameters and white balance) and then displayed on the computer.

 When the following operations are performed, RAW images are processed and displayed:

• When the preview window is switched from the main window

• When the processing parameters are specified on the preview or main window

• When the image is converted to the TIFF or JPEG format and saved

• When the image is transferred to the specified retouching software

When the images are processed, it takes a while to display them.

 Approximate processing times

• The processing times given here are only approximations. Actual processing times 

vary widely depending on the images and the computer system.

• Processing times are based on Canon testing standards.

(OS: Windows XP; CPU: 2.2 GHz Pentium 4; RAM: 256 MB)

• The processing time in the retouching software includes starting up time of the retouching 

software (when using Adobe Photoshop 7.0).

Operation Details

Camera Model

Switching from the main 

window to the preview window

Transferring an image to the 

specified retouching software

EOS 20D Approx. 3 sec. Approx. 35 sec.

EOS 10D Approx. 2 sec. Approx. 30 sec.

EOS DIGITAL REBEL/

300D DIGITAL
Approx. 2 sec. Approx. 30 sec.

EOS D60 Approx. 3 sec. Approx. 30 sec.

EOS D30 Approx. 2 sec. Approx. 20 sec.

You cannot display images in the preview window (W-22) or edit RAW images saved on 

a memory card in the camera directly. Work with the images saved on your computer 

from the memory card.

Processing RAW Images
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You can specify the processing parameters in the RAW adjustment tool palette.

 This processing applies the specified parameters virtually and does not affect the original 

RAW images in any way. Consequently, you can redo the processing as often as you like 

with different parameters and then reset the modified parameters to the settings used when 

the shot was taken.

 Linear processing can be specified when an image is saved (W-41) or is transferred to 

retouching software (W-44).

 The procedure below is an operating method in the preview window, but you can set 

processing parameters with the same operation in the main window also. However, in the 

main window, you cannot click the [Preview] checkbox and the processing parameters you 

have set are immediately reflected in the image.

1 Display the RAW images in the preview window (W-22).

 If the RAW adjustment tool palette is hidden, select the [View] menu � [Tool palette] 

to show it.

2 Specify the processing parameters (W-33 to W-40).

 Clicking the [Reset to Shot Settings] button restores the settings to the values used 

when the shot was taken.

 If you click the [Preview] checkbox, the specified processing parameters are applied 

to the RAW images.

3 Click the [Update] button.

 The RAW images are processed 

according to the specified 

processing parameters.

4 Save (W-41) or transfer images (W-44).

The processing parameters set with the EOS Viewer Utility in the RAW images of a 

camera other than the EOS 20D are cancelled when you exit the EOS Viewer Utility, and 

are reset to the processing parameters for when shooting. Either convert the RAW image 

specified with the processing parameters to a TIFF or JPEG image and save (W-41), or 

transfer to retouching software (W-44) and save. 

When multiple images are selected in the main window, the specified processing 

parameters are applied to all the selected RAW images.

Specifying the Processing Parameters
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You can adjust the brightness of an image in the range of +/–2 stops in 0.1-stop increments.

 This function is only available with RAW images of the EOS 20D, EOS 10D, EOS 

DIGITAL REBEL/300D DIGITAL and EOS D60.

Drag the slider left or right to adjust the brightness.

 The adjusted value is specified in 

the RAW adjustment tool palette.

Adjusting the Brightness (Digital Exposure Compensation)

Adjustment value set with the slider.
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You can adjust the white balance in the images.

Selecting the White Balance
You can select the white balance that is the closest to the light source when shots were taken.

Select the white balance from the list box.

 [Shade] and [Color temperature] 

are not displayed for the EOS D60 

and EOS D30 RAW images.

White Balance Details
Color Temp.

K (Kelvin)

Auto Automatically adjusts the white balance. Approx. 3000 to 7000

Daylight For sunny daylight outdoors. Approx. 5200*

Shade For shaded areas outdoors. Approx. 7000

Cloudy For cloudy or hazy days and during sunset. Approx. 6000

Tungsten For tungsten (light bulb) light. Approx. 3200

Fluorescent For white fluorescent light. Approx. 4000

Flash When flash is used. Approx. 6000

Color temperature
You can manually set color temperature for 

2800 to 10000K (in 100K increments) (W-35).
Approx. 2800 to 10000

* Approximately 5500 with the EOS D30 RAW images.

 The selected white balance is specified in the RAW adjustment tool palette.

Adjusting the White Balance
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Specifying the Color Temperature
You can specify the color temperature to adjust the white balance.

 This function is only available with RAW images of the EOS 20D, EOS 10D and EOS 

DIGITAL REBEL/300D DIGITAL.

1 Select [Color temperature] from the list box.

2 Enter a color temperature.

 Enter the color temperature in the 

[Color temperature] input box in 

the range of 2800K to 10000K (in 

100K increments).

 The entered color temperature is 

specified in the RAW adjustment 

tool palette.
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Click White Balance Function
Makes white the standard for the part you have selected and automatically adjusts the white 

balance.

1 Click the [Click White Balance] button.

 When you move the cursor over 

the image, the cursor [ ] changes 

to [ ].

2 Click the part where white is to be the standard.

 The white balance is adjusted so that the point clicked appears white.

 When you use Click White Balance Function, even though you do not click the 

[Preview] checkbox, the adjusted white balance is applied to the images.

 When you use Click White Balance Function, [Click WB] is displayed in the [White 

Balance] list box.

 You can adjust by selecting the neutral gray parts of the image.



Editing Raw Images

W-37

W

3

W
o

rk
in

g
 w

it
h

 I
m

a
g

e
s
 i
n

 t
h

e
 E

O
S

 V
ie

w
e

r 
U

ti
lit

y

Correcting the White Balance
You can correct the standard color temperature of the white balance. By using this function, you 

can obtain the effectiveness similar to the color temperature converting filter or color 

compensating filter (third-party product). The range of compensation is 9 levels for each color.

This function is especially useful for users who understand the role and effect of the color 

temperature converting filter or color compensating filter.

 This function is only available with the EOS 20D RAW images.

You can adjust the contrast of an image.

Drag the slider left and right to adjust the white balance.

 The corrected value is specified in the RAW adjustment tool palette.

One level of blue/amber hue is equal to five mireds of the color temperature converting 

filter. (Mired: the unit of the density of the color temperature converting filter)

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

 [Mid.Low] and [Mid.High] are not 

displayed for the EOS D60 and 

EOS D30 RAW images.

The corrected value specified using the slider.

Correction value when shooting.

Dragging the slider toward B-side adds 
blue hue, and toward A-side, amber hue.

Dragging the slider toward G-side adds 
green hue, and toward M-side, magenta hue.

Selecting the Contrast
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Select the color adjustment options with the radio buttons to make each type of adjustment.

 Selecting of color adjustment options is only available with EOS 20D RAW images.

Selecting the Color Saturation

Adjusting the Color Tone
 This function is only available with RAW images of the EOS 20D, EOS 10D, EOS 

DIGITAL REBEL/300D DIGITAL and EOS D60.

Select the [Standard] radio button or the [Monochrome] radio button.

 With the radio button you have 

selected, you can make the 

following color adjustments. Also, 

if you select [Monochrome], the 

image will become monochrome. 

[Standard]: Color Saturation, Color 

Tone 

[Monochrome]: Filter Effect, 

Toning Effect

 See the section below for 

adjustment methods.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

 [Mid.Low] and [Mid.High] are not 

displayed for the EOS D60 and 

EOS D30 RAW images.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

 The more negative the value, the 

redder the image becomes, and 

the more positive the value, the 

more yellow.

 [–2] and [+2] are not displayed for 

the EOS D60 RAW images.

Color Adjustment
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Filter Effect
 This function is only available with EOS 20D RAW images.

Toning Effect
 This function is only available with EOS 20D RAW images.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.
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You can set the color space of the images you have taken.

 This function is only available with RAW images of the EOS 20D, EOS 10D and EOS 

DIGITAL REBEL/300D DIGITAL.

You can adjust the edge sharpness of an image.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

 The specified color space is recorded in the ICC profile attached to a TIFF image 

converted and saved from a RAW image (W-41).

 An ICC profile contains color information, such as color properties and color spaces 

of devices which are authorized by International Color Consortium (ICC). With this 

ICC profile, many color management systems can minimize the color differences 

between devices.

Select a setting from the list box.

 Higher values give higher levels of 

edge sharpening.

 [Mid.Low] and [Mid.High] are not 

displayed for the EOS D60 RAW 

images.

 [Off], [Mid.Low] and [Mid.High] are 

not displayed for the EOS D30 

RAW images.

 The selected setting is specified in 

the RAW adjustment tool palette.

Specifying the Color Space

Selecting the Sharpness
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Saving Images
You can convert and save RAW images to TIFF or JPEG images, and save JPEG images as 

another name. When you convert RAW images to the TIFF format and save them, the specified 

color space data (W-40) is attached to each of images as the ICC profile automatically.

1 Select images to be saved (W-25).

2 Click the [Save File] button and select [Convert and save in file] 

from the menu that appears.

 The [Save File] dialog box 

appears.

3 Specify the settings and click the [OK] button.

 The images are saved in the 

selected folder.

 When you convert RAW images to the TIFF images and save them, the ICC profile is 

attached to each of images automatically. An ICC profile contains color information, 

such as color properties and color spaces of devices which are authorized by 

International Color Consortium (ICC). With this ICC profile, many color management 

systems can minimize the color differences between devices.

 Alternatively, you can perform the same operation using the menu that appears by 

right-clicking.

Restores the settings to their 
original ones and closes the 
[Save File] dialog box.

Applies the settings 
and saves the image.
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Allows you to specify the folder in 
which the image will be saved.

The image is saved as a new image in the same folder as the selected image.

When the [Save in following specified folder] radio button has been 
selected, this button allows you to specify the folder in which the image 
will be saved. The name of the destination folder is displayed next to 
the [Browse] button.

Select a setting for [Quality] (compression ratio) when you have selected 
[JPEG] from the list box, from [4 (Highest image quality)] through [1 
(High Compression Ratio)]. Higher values give higher quality of the 
JPEG image.

If some of the images to be saved are RAW images, select [Do not convert], [JPEG], or [TIFF] for 
the conversion format. If you select [TIFF], you can select the number of bits used when you save 
images from [8bit/ch], [16bit/ch] or [16bit/ch linear]. If you select [JPEG], the images are saved in 
the [8bit/ch] format.
The extensions used for the saved files are shown below.

Conversion Format Extension

Do not convert

EOS 20D .CR2

EOS 10D, EOS DIGITAL REBEL/300D 
DIGITAL, EOS D60, EOS D30

.CRW

JPEG (8bit/ch) .JPG

TIFF (8bit/ch) .TIF

TIFF (16bit/ch, 16bit/ch linear) .TIF

Click this checkbox to also save JPEG 
images taken in RAW+JPEG format.
* This function is only available with 

EOS 20D RAW+JPEG images.

Specify the resolution for 
saving images in a range 
of 10 to 2000 pixels/inch.
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 A JPEG image simultaneously recorded with a RAW image can be extracted and saved.

 This function is only available with RAW images of the EOS 10D and EOS DIGITAL 

REBEL/300D DIGITAL and EOS D60.

 The EOS DIGITAL REBEL/300D DIGITAL and EOS D60 simultaneously record a Middle/

Fine JPEG image and the EOS 10D simultaneously records the JPEG image set up in the 

camera.

 The contents that can be set are the same as [Save folder] and [File Name] of “Saving 

Images” (W-41).

1 Select the RAW image from which a JPEG image is to be 

extracted. (W-25)

2 Click the [Save File] button and select [Extract Save JPEG] from 

the menu that appears.

 The [Extract & save JPEG] dialog 

box appears.

3 Specify the desired settings and click the [OK] button.

 The JPEG image is saved in the selected folder.

Click this checkbox when you want to save the image without changing the name.

* This button does not work with the camera you are using.

Click this checkbox when saving the file after converting a RAW image to a 
JPEG image or TIFF image adds one of the following at the end of the file name.

Conversion Format Conversion Format Name

JPEG RJ

TIFF (8bit/ch) RT8

TIFF (16bit/ch, 16bit/ch linear) RT16, RT16L

This is text inserted before the file number. You can enter up to 12 characters. 
When you enter text, an example appears in the [Example] field below the text box.

Enter the number of digits in the sequential 
number that attaches to the file and the 
starting number used. A maximum of 9 
digits can be specified.

Extracting JPEG Images from RAW Images
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Transferring Images to Retouching Software
You can transfer the images displayed in the EOS Viewer Utility to retouching software.

The descriptions given here use Adobe Photoshop 7.0, as an example.

 In order to transfer images, you will need retouching software such as Adobe 

Photoshop.

 Be sure to specify the image transfer settings before transferring images.

1 Click the [Transfer images] button.

 The [Image Transfer] dialog box 

appears.

2 Click the [Browse] button.

 The [Open] dialog box appears.

3 Select the retouching software (Photoshop 7.0) to which the 

image will be transferred.

 Select the [C:] drive � [Program 

Files] � [Adobe] � [Photoshop 

7.0] � [Photoshop]. Then click the 

[Open] button.

 Photoshop is specified and the 

dialog box closes.
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4 Select the radio button and then select a folder in which the 

images to be transferred will be saved.

5 Specify [Output settings] and [File Name] and then click the [OK] 

button.

 See “Saving Images” (W-41) for the procedure for specifying [Output settings] and 

[File Name].

 Photoshop starts up and displays the transferred images.

 The transferred images are saved in the folder that you have selected in step 4.

 It is recommended that you should use the retouching software (third-party product) 

that supports 16-bit images for the one to be specified for the transfer image function.

 When you convert RAW images to the TIFF format and transfer them, the specified 

color space data (W-40) is attached to each of the images as the ICC profile 

automatically. 

 Alternatively, you can perform the same operation using the menu that appears by 

right-clicking.

The images to be transferred are saved 
as new images in the same folder.

Click the [Browse] button and then select 
a folder in which the images to be 
transferred will be saved.
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Specifying the Preferences
You can specify the preferences for the EOS Viewer Utility.

1 Select the [File] menu � [Preferences].

 The [Preferences] dialog box appears.

2 Specify the settings and click the [OK] button.

 The settings are applied and the [Preferences] dialog box closes.

You can also select in the preview window whether the image displayed is the RAW 

image or the simultaneously recorded JPEG image (W-22).

Allows you to select whether the folder that was open the last time is displayed or the 
specified folder is always displayed when the EOS Viewer Utility starts up.

Select the information to be displayed below images from [File Name] and [Shooting Date/Time]

Restores the settings to their 
original ones and closes the 
[Preferences] dialog box.

Applies the settings and closes 
the [Preferences] dialog box.

Restores the settings 
to the default settings.

Displays the monitor profile set in the operating system. 
Settings are made in the operating system.

Select whether the image displayed in the preview window is the RAW 
image or the simultaneously recorded JPEG image.
* Only compatible with EOS 20D RAW+JPEG images and EOS 10D, 

EOS DIGITAL REBEL/300D DIGITAL and EOS D60 RAW images.
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Setting the IPTC Information
IPTC stands for International Press Telecommunications Council and refers to a standard for 

communications and information exchange tags attached to images. The standard was 

established by newspaper and communications companies to allow problem-free transmission 

of images.

You can attach this IPTC information to JPEG images, or to TIFF and JPEG images that were 

converted from RAW images and saved with the EOS Viewer Utility. You can also save the 

IPTC information on your computer, and then load the saved information and apply it to other 

images.

1 Select a JPEG or a TIFF image (W-25).

2 Click the [IPTC information] button.

 The [IPTC information] dialog box 

appears.

3 Enter information (W-48, W-49).

 Select any of [IPTC-1], [IPTC-2], or [IPTC-3] tab to display the tab sheet, and enter 

the information.

 The entered IPTC information can be saved on the dialog box that appears by 

clicking the [Save As] button.

 The saved IPTC information can be loaded on the dialog box that appears by clicking 

the [Read] button.

4 Click the [Save] button.

 The specified IPTC information is applied to the image.

5 Click the [OK] button.

 The [IPTC information] dialog box closes.

IPTC information settings data saved on your computer is compatible with the EOS 

Viewer Utility for both Windows and Macintosh.
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IPTC-1 tab
IPTC-2 tab IPTC-3 tab

Loads the IPTC information saved on your computer.

Saves the entered IPTC information on your computer.

Cancels the entered IPTC information.

Displays the image for which you will enter 
the IPTC information.

When multiple images are selected, this 
button displays the IPTC information for the 
previous image.

When multiple images are selected, this 
button displays the IPTC information for the 
next image.

Displays the image No. in a sequence.

Closes the [IPTC information] dialog box.

Settings on the [IPTC-1] tab sheet 

You can enter up to 64 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 2000 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

Displays the IPTC information entered before the 
[Previous] or [Next] button was clicked.

Applies the entered IPTC information to the image.
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Settings on the [IPTC-2] tab sheet 

You can enter up to 10 characters.

Select [Highest Priority (=1)], [Normal (=5)], or 
[Low Priority (=8)] from the list box.

You can enter up to 256 characters.

You can enter up to 8 characters.

You can enter up to 11 characters.

You can enter up to 32 characters.

Settings on the [IPTC-3] tab sheet 

You can enter up to 3 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 256 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.
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Specifying the Camera Settings
You can specify the owner’s name and data/time in the camera. 

1 Connect the camera to your computer (W-9).

 The dialog box on which the camera 

model is displayed appears.

 Your camera model is displayed in 

EOS XXX.

 For Windows Me, the [Scanner and 

Camera Wizard] dialog box appears.

 Click the [Cancel] button to close 

the open window.

2 Start up the EOS Viewer Utility (W-14).

3 Select the [Options] menu � [Camera Settings].

 The [Camera Settings] dialog box appears.
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4 Specify the settings.

 With the EOS D30, the [Parameters] button is displayed. For details on [Parameters], 

refer to the Software Instruction Manual supplied with your camera.

5 Click the [OK] button.

 The settings are applied and the [Camera Settings] dialog box closes.

Formatting a memory card deletes all the data on the card. Because formatting also 

deletes protected images, you should check the data recorded on the card carefully 

before proceeding.

Enter a value or click the 
[�]/[�] buttons to specify 
the date and time.

The battery level of the 
camera is indicated by 

[  ] or [  ].
When you are using the 
AC Adapter Kit (optional) 

or DC Coupler, [  ] is 

displayed.

This box shows the camera model, body ID (serial number) 
and firmware version.

This box shows whether a 
memory card is loaded in 
the camera along with the 
available space on the 
card and its total capacity.
You can also initialize the 
memory card by clicking 
the [Format] button.

Imports the date and time 
from your computer.

Enter the name of a 
camera owner. You can 
enter up to 31 characters.

Applies the settings that you have 
specified to the camera and closes 
the [Camera Settings] dialog box.

Restores the parameters to their 
original ones and closes the 
[Camera Settings] dialog box.
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Merging Images with the PhotoStitch
You can merge multiple JPEG images to create a panorama shot.

1 Click the [Start] button � select [All Programs] ([Programs] in 

other versions of Windows) � [Canon Utilities] � [PhotoStitch] �

[PhotoStitch].

 [PhotoStitch Launcher] appears.

2 Click the [Merge Images] button.

 The PhotoStitch starts up.

 Follow the instructions in the guidance window to merge the images.

 Refer to the PhotoStitch Help menu for more details.

 You cannot merge RAW images in the PhotoStitch.

 Up to four images can be merged using the PhotoStitch.

 You will need QuickTime 3.0 or later to save merge images made using the 

PhotoStitch in the QuickTime VR format. If QuickTime 3.0 or later is not already 

installed on your computer, obtain and install it separately.
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Remote Shooting in 

the EOS Capture

This chapter describes how to use the EOS Capture for taking shots and 

specifying the camera settings remotely from your computer.

For more information on the restrictions of the EOS Capture, refer also to the source 

listed below.

Readme: Click the [Start] button � select [All Programs] ([Programs] in other 

versions of Windows) � [Canon Utilities] � [EOS Capture xx] (“xx” is the 

version) � [EOS Capture Readme].

 Remote shooting in the EOS Capture is only available with the EOS 20D.

Starting the EOS Capture...................................................................... W-54

Remote Shooting ................................................................................... W-56

Single-frame Shooting ........................................................................ W-56

Timer Shooting ................................................................................... W-57

Interval Timer Shooting ...................................................................... W-58

Specifying the Camera Settings........................................................... W-59

Camera Settings................................................................................. W-59

White Balance Adjustment ................................................................. W-61

Specifying the Save Destination......................................................... W-62
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Starting the EOS Capture
 Remote shooting in the EOS Capture is only available with the EOS 20D.

1 Connect the camera to your computer (W-9).

 The dialog box on which the 

camera model is displayed 

appears.

 Your camera model is displayed in 

EOS XXX.

 For Windows Me, the [Scanner 

and Camera Wizard] dialog box 

appears.

 Click the [Cancel] button to close 

the open window.

2 Start up the EOS Viewer Utility (W-14).

3 Select the folder to save the image in.

 Select a folder in the Folder Tree 

Area to save the image in, or 

create a new folder (W-18). (The 

[Capture] folder is created in the 

[My Pictures] folder here as an 

example.)

4 Click the [EOS Capture] button.

 The EOS Capture main window 

appears.
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 To exit the EOS Capture, select the [File] menu � [Exit].

EOS Capture main window

5 Click the [Release] button to take a shot (W-56).

The EOS Capture operates in conjunction with the EOS Viewer Utility. Therefore, when 

you exit the EOS Viewer Utility, the EOS Capture also exits.

Allows you to check and 
specify the camera 
settings (W-59).

Release button (W-56)

Status

Displays the status while 
specifying the settings.

 button (W-61)

Shows/hides the white  
balance adjustment dialog 
box.

Rotate button

The image is downloaded, 
rotating 90 degrees each 
time you click the button, 
regardless of the vertical or 
horizontal position of the 
camera.
* To use the rotation function, 

click [Rotate Image] 
checkbox in [Save settings] 
dialog box (W-62).
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Remote Shooting
You can control the camera from your computer and take single-frame shots, timer shots and 

interval timer shots. The images are automatically saved on your computer.

1 Set the camera up ready to shoot.

2 Make various settings.

 See “Camera Settings” (W-59) and “White Balance Adjustment” (W-61) for 

information on how to specify the camera settings.

 See “Specifying the Save Destination” (W-62) for information on how to specify the 

settings for saving images.

3 Click the [Release] button.

 The shot images are displayed in 

the EOS Viewer Utility and saved 

in your computer automatically.

Before you use the Remote Shooting function, be sure to check that the camera is ready 

for shooting. If the camera is not ready for shooting (the lens is not attached, etc.), you 

cannot perform the operation as explained.

Alternatively, you can press the space bar to shoot.

Single-frame Shooting
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Approximate Transfer Time for Shooting RAW Images

• The transfer time given here is only an approximation. Actual transfer time varies 

widely depending on the images and the computer system.

• The time for images shot in JPEG format will be shorter than those shown above.

• Transfer time is based on Canon testing standards. 

(Time until images appear in the EOS Viewer Utility main window after you uncheck the 

[Save also on the camera’s memory card] checkbox and click the [Release] button in the 

EOS Capture main window using the following: OS: Windows XP; CPU: 2.2 GHz Pentium 

4; RAM: 256 MB)

EOS 20D Approx. 5 seconds

 When the camera is set to One Shot AF, you cannot take shots if the camera cannnot 

focus.

If you cannot take shots with the auto focusing, focus manually and then take a shot.

 If you take remote shooting while you are using the Explorer in the WIA Driver to 

display images on the camera, Remote Shooting function may not operate correctly.

The number of available shots changes depending on the available capacity on your 

computer’s hard disk. You can check the number of available shots with the [Shots to 

Go] (W-59).

1 Select the [Tool] menu � [Timer shooting].

 The [Timer shooting setting] dialog box appears.

2 Enter a delay time and click the [OK] button.

 You can set a value between 0 

seconds and 99 minutes 59 

seconds in 1-second increments.

 Timer shooting shots are taken.

Timer Shooting
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1 Select the [Tool] menu � [Timer shooting].

 The [Timer shooting setting] dialog box appears.

2 Click the [Interval timer shooting] checkbox.

3 Enter the shooting interval and the number of shots. Then click 

the [OK] button.

 You can set a shooting interval 

between 5 seconds and 99 

minutes 59 seconds in 1-second 

increments.

 You can set up to a maximum of 

1999 shots.

 Interval timer shooting is 

performed using the specified 

interval between shots and the 

specified number of shots.

On some types of computers, if you set a short interval between shots and there is 

insufficient time to download and save the images, it may not be possible to take shots at 

the specified interval. If this occurs, set a longer interval between shots and take the 

shots again.

Interval Timer Shooting
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Specifying the Camera Settings
You can check and change the settings in the camera from your computer remotely.

You can check and specify the camera settings.

1 Check the camera settings.

‘

* The above window shows all the information at once. In actual use, only the 

information needed is displayed.

Camera Settings

Shooting mode

Displays the shooting 
mode.

White Balance

Displays/specifies 
the white balance.

Exposure compensation

Displays/specifies the exposure 
compensation value.

Image recording quality
Displays/specifies the image 
recording quality.

ISO Speed

Displays/specifies the ISO speed.

Aperture value

Displays/specifies Av (aperture value).
(Not displayed when Shutter-priority AE or 
Program AE is specified for the shooting mode)

Shutter speed

Displays/specifies Tv (shutter speed).
(Not displayed when Aperture-priority AE or Program AE is specified for the shooting mode)

Save destination display

Displays the destination folder 
to which images will be saved.
(When you click the [Save also 
on the camera’s memory card] 
checkbox, the camera/PC icon 
is displayed, and when you 
uncheck the checkbox, the PC 
icon is displayed.)

Color temp.

Specify the color temperature in a range 
of 2800K to 10000K.

Metering mode

Displays/specifies 
the settings of the 
metering mode.

Color temp.

Specify the color temperature in a range 
of 2800K to 10000K.

AF mode
Displays the AF mode.

Drive mode

Displays the drive mode.

Warning display
Displayed when the remote shooting is 
impossible due to inappropriate settings.

Battery status

When you are using a battery, 
[  ] is displayed. When 
you are using the AC Adapter 
Kit (optional) or DC Coupler 

Kit, [  ] is displayed.

Shots to Go

Displays the number of 
available shots.

Bracket shots

Displayed when any of WBB/
AEB/FEB is specified.
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2 Click the icon.

 The icon displayed here shows 

exposure compensation as an 

example.

3 Use the button to change a value.

 The changed settings are applied to the camera.

 Before you specify the settings, be sure to check that the camera is ready for 

shooting. If the camera is not ready for shooting (the lens is not attached, etc.), you 

cannot make some of the settings.

 Set functions which you cannot set with EOS Capture (drive mode, AF mode etc.) in 

the camera.

1-step down settings button

Allows you to decrease the value by 1 step.

Minimum settings button

Specifies the minimum value.

1-step up settings button

Allows you to increase the value by 1 step.

Maximum settings button

Specifies the maximum value.
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You can compensate white balance with the blue/amber/green/magenta digital filter.

 If the dialog box has not appeared, click the [ ] button.

Click the compensation position.

 The changed settings are applied to the camera.

White Balance Adjustment

Compensate magenta.

Compensate green.

Compensate blue. Compensate amber.

Displays the 
compensation value.
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You can specify save destination files and file names.

Save settings dialog box

1 Select the [File] menu � [Save destination settings].

 The [Save settings] dialog box appears.

2 Specify desired settings and click the [OK] button.

Specifying the Save Destination

Allows you to change the destination folder to which images 
will be saved. The name of the destination folder is displayed 
next to the [Browse] button.

Cancels all the settings, and restores the settings to their original ones.

Clicking the checkbox also saves images 
on the memory card in the camera.

Use this field to enter a file name when saving 
an image. The file name can consist of up to 
18 characters.

Enter a sequential number with a range of 0000 
to 9999 that is added to the end of the file name.

Click the checkbox to enable use of the rotation function (W-55).

Applies the settings and closes the [Save settings] dialog box.
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Downloading JPEG 

Images with the Driver

This chapter describes how to download JPEG images using the WIA 

Drivers for Windows XP or Windows Me, and the TWAIN Drivers for 

Windows 2000 or Windows 98 SE.

A number of restrictions apply to the WIA Driver. You must read the “WIA 

Driver Readme” file before using the WIA Driver.

Readme: Click the [Start] button � select [All Programs] ([Programs] in Windows 

Me) � [Canon Utilities] � [EOS XXX WIA Driver] � [WIA Driver 

Readme].

For more information on the restrictions of the TWAIN Driver, refer also to the 

sources listed below.

Readme: Click the [Start] button � select [Programs] � [Canon Utilities] � [EOS 

XXX TWAIN Driver] � [TWAIN Driver Readme].

Help: Displayed by clicking the [Help] button in the TWAIN Driver main 

window.

Your camera model is displayed in EOS XXX.

Downloading Images with the WIA Driver........................................... W-64

Downloading with [Scanner and Camera Wizard] .............................. W-64

Downloading with Explorer ................................................................. W-66

Downloading with the WIA TWAIN ..................................................... W-67

Downloading Images with the TWAIN Driver ...................................... W-68
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Downloading Images with the WIA Driver
You can download JPEG images using the [Scanner and Camera Wizard] dialog box, Explorer 

or WIA TWAIN. Windows XP users can use the same procedure to download JPEG images 

using the PTP function (W-12). 

 See Chapter 3 to download RAW images.

 The camera name is shown in the operation screens as “EOS XXX”.

You can download JPEG images to your computer by following the instructions on the dialog boxes.

1 Connect the camera to your computer (W-9).

 The dialog box on which the camera model is displayed appears.

 For Windows Me, the [Scanner and Camera Wizard] dialog box appears. Proceed to step 3.

2 Select [Microsoft Scanner and Camera Wizard], and then click the 

[OK] button.

 The [Scanner and Camera 

Wizard] dialog box appears.

3 Click the [Next] button.

 The [Choose Pictures to Copy] 

dialog box appears.

 For Windows Me, the [Picture 

Selection] dialog box appears.

Downloading with [Scanner and Camera Wizard]
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4 Select the image(s) you wish to download and click the [Next] 

button. 

 The [Picture Name and 

Destination] dialog box appears.

 For Windows Me, the [Picture 

Destination] dialog box appears.

5 Select the destination folder, enter the file name and click the 

[Next] button.

 The images are downloaded and the [Other Options] dialog box appears.

 If you do not select the destination folder, a new folder is created in [My Pictures] and 

images are saved in that folder.

 For Windows Me, select the destination folder, enter the file name and click the 

[Finish] button. The images are saved and the [Picture Destination] dialog box closes.

6 Select the [Nothing. I’m finished working with these pictures] 

radio button and click the [Next] button.

 The [Completing the Scanner and Camera Wizard] dialog box appears.

7 Click the [Finish] button.

 The images are saved and the 

[Scanner and Camera Wizard] 

dialog box closes.
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You can download JPEG images to your computer by dragging and dropping them. 

1 Connect the camera to your computer (W-9).

 The dialog box on which the camera model is displayed and the [Scanner and 

Camera Wizard] dialog box appear.

 Click the [Cancel] button to close all the open windows.

2 Start up Explorer and select a folder.

 You can start Explorer by right-

clicking the [Start] button and 

selecting [Explorer] from the menu 

that appears.

 In the Explorer view, double-click 

the connected camera’s icon and 

then click the [xxxCANON] folder 

(For Windows Me, double-click the 

[xxxCANON] folder). (“xxx” 

represents a number 100 to 999.)

 With the EOS D60 and EOS D30, 

click the camera icon.

 The camera’s images will be 

displayed as thumbnails in the 

Explorer view.

3 Save the image.

 Drag and drop the image to the 

folder in the Explorer view.

 The image is saved.

If you attempt to use Remote Shooting while you are using Explorer to display images on 

the camera, the Remote Shooting function may not operate correctly.

Downloading with Explorer
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You can download JPEG images to your computer by using the TWAIN Driver-compatible 

retouching software. The descriptions given here use Adobe Photoshop 7.0, as an example.

1 Connect the camera to your computer (W-9).

 The dialog box on which the camera model is displayed and the [Scanner and 

Camera Wizard] dialog box appear.

 Click the [Cancel] button to close all the open windows.

2 Start Photoshop.

 Click the [Start] button � select [All Programs] ([Programs] in Windows Me) � [Adobe 

Photoshop 7.0].

 Photoshop starts up.

3 Select the [File] menu � [Import] � [WIA-EOSXXX].

 The [Get Pictures from Canon EOS XXX] dialog box appears.

4 Select the image(s) you wish to download and click the [Get 

Pictures] button.

 The selected image(s) will be 

downloaded to Photoshop.

The method for starting the application and the dialog box contents differ depending on 

your retouching software. Refer to the retouching software User’s Manual for details.

Downloading with the WIA TWAIN
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Downloading Images with the TWAIN Driver
You can download JPEG images to your computer by using the TWAIN Driver-compatible 

retouching software. The descriptions given here use Adobe Photoshop 7.0, as an example.

 See Chapter 3 to download RAW images.

 The camera name is shown in the operation screens as “EOS XXX”.

 Refer to the Software Instruction Manual supplied with the camera for information about the 

TWAIN Driver for the EOS D60 and EOS D30.

1 Connect the camera to your computer (W-9).

 The dialog box on which the camera model is displayed appears.

 Click the [Cancel] button to close all the open windows.

2 Start Photoshop.

 Click the [Start] button � select [Programs] � [Adobe Photoshop 7.0].

 Photoshop starts up.

3 Select the [File] menu � [Import] � [Canon EOSXXX].

 The TWAIN Driver starts and the 

JPEG image in the camera is 

displayed.

 To exit the TWAIN Driver, select   

the [File] menu � [Exit]. 

4 Select the image to be transferred and select the [File] menu �

[Transfer Images].

 The image transferred to Photoshop is displayed.

 You can also transfer images by double-clicking a thumbnail image.

 The method for starting the application and the dialog box contents differ depending 

on your retouching software. Refer to the retouching software User’s Manual for 

details.
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Troubleshooting and 

Uninstallation

This chapter provides troubleshooting and describes the software 

uninstallation procedures.

Troubleshooting .................................................................................... W-70

Uninstalling the Software...................................................................... W-74

Uninstalling the Software.................................................................... W-74

Uninstalling the Driver ........................................................................ W-75

Index ....................................................................................................... W-76
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Troubleshooting
When the “Could not complete installation correctly” or “Communication between the camera 

and computer failed” message appears, check the items described below.

 The camera name is shown in the operation screens as “EOS XXX”.

 If you are using Windows XP Professional or Windows 2000, are you using 

the computer under a user setting other than [Computer administrator] or 

[Administrator]?

� You cannot install software if a user setting other than [Computer administrator] or 

[Administrator] is selected. Select the [Computer administrator] user setting in Windows 

XP Professional or the [Administrator] user setting in Windows 2000. For detailed 

information on selecting the user setting, refer to the computer User’s Manual.

 Is the cable firmly plugged into its socket?

� To complete the installation, ensure that the plugs on the dedicated cable are securely 

plugged into the ports on the camera and computer when you connect the camera to 

your computer (W-9).

 Are the camera and computer set up correctly for communication?

� Is the camera’s power switch set to <ON>?

� Even when the camera’s power switch is set to <ON>, operation of the Auto power off 

function will automatically switch the camera off. To prevent this, set the Auto power off 

function to [Off]. (Refer to “Menu Operations” in the camera’s Instruction Manual.)

 Does the [Add New Hardware Wizard] ([Found New Hardware Wizard] in 

Windows 2000) dialog box appear during installation?

� Click the [Cancel] button, disconnect the dedicated cable, and then repeat the 

installation procedure from the beginning. 

 Doesn’t the installer panel appear?

� Use the following procedure to display the installer panel.

Click the [Start] button � [My Computer]. (In other versions of 

Windows, double-click [My Computer] on the desktop.) � right-

click the CD-ROM drive containing the CD � select [Open] from 

the menu that appears � double-click the icon on the right.

Installation failed.
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 Is the driver installed?

� The driver is required for communications between the camera and computer. When you 

want to communicate between the camera and computer, be sure to install the driver 

shown below appropriate to your windows.

• Windows XP/Windows Me: WIA Driver

• Windows 2000/Windows 98 SE: TWAIN Driver

 Have you installed the WIA Driver or TWAIN Driver?

� Even if you have installed the WIA Driver or TWAIN Driver, installation is not completed 

unless the camera is connected to the computer. Insert the Solution Disk into the CD-

ROM drive, install the WIA Driver or TWAIN Driver, and then connect the camera to your 

computer.

 Does your computer comply with these requirements?

� PC with Windows XP, Windows 2000, Windows Me or Windows 98 SE preinstalled and 

equipped with an a USB port.

* Operation is not guaranteed when a connection is used on computer systems other 

than those listed above.

 Are the camera and computer connected correctly?

� Connect the camera to your computer correctly using the dedicated cable (W-9).

 Is the correct communication mode selected on the camera?

� When using the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D DIGITAL, set the 

camera’s communication mode to [Normal]. (W-8) With the EOS 10D, you must also 

change the firmware to version 2.0.0 or later. For details on changing, see the Canon 

website.

 Is there sufficient charge left in the camera battery?

� Your computer does not supply power to the camera. With the EOS 20D, EOS 10D and 

EOS DIGITAL REBEL/300D DIGITAL, connect to the camera with an AC Adapter Kit 

(optional). With the EOS D60 and EOS D30, Connect to the camera with the DC Coupler 

supplied. Or, load a fully charged battery into the camera before connecting it to your 

computer.

 Do you have more than one camera connected to your computer?

If you connect more than one camera to the same computer, the driver and camera may not 

operate normally.

� Exit the software and disconnect all the dedicated cables. Then connect only one 

camera to the same computer again.

I have installed the software but the camera and 
computer cannot communicate.
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 Is the driver operating normally?

Connect the camera to your computer 

with the dedicated cable and set the 

camera’s power switch to <ON> (W-9) 

and open [Device Manager] (W-73). Click 

the plus symbol [+] to the left of [Imaging 

devices] and check that the connected 

camera is displayed.

� If the connected camera is not displayed, the driver is not operating normally. Briefly 

disconnect and then reconnect the dedicated cable, ensuring that the connection is 

secure. If the connected camera still does not appear, use the following procedure to re-

install the driver.

1 Disconnect the dedicated cable and delete the driver (W-75).

2 Re-install the driver (W-4).

� When the [X], [!] or [?] symbol is displayed beside the connected camera, part of the 

driver is missing or corrupted. Use the following procedure to re-install the driver.

1 Delete the camera displayed in [Imaging devices].

2 Disconnect the dedicated cable and delete the driver (W-75).

3 Re-install the driver (W-4).

 Is the driver installed correctly?

Connect the camera to your computer with the dedicated cable and set the camera’s power 

switch to <ON> (W-9) and open [Device Manager] (W-73). Click the plus symbol [+] to the 

left of [Other devices] or [Unknown devices] and check whether the connected camera or 

[Canon Digital Camera] is displayed.
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� If the connected camera or [Canon Digital Camera] is displayed in [Other devices] or 

[Unknown devices], the driver was not installed correctly. Use the following procedure to 

re-install the driver.

1 Delete the camera or [Canon Digital Camera] displayed in [Other devices] or 

[Unknown devices].

2 Disconnect the dedicated cable and delete the driver (W-75).

3 Re-install the driver (W-4).

 Did you set the camera’s power switch to <ON>?

� If you did not set the camera’s power switch to <ON>, proceed as follows:

1 Disconnect the dedicated cable from the camera and computer.

2 Install the Solution Disk software on your computer using the correct installation 

procedure (W-4) and then connect the camera to your computer to complete the 

installation (W-9).

� If you set the camera’s power switch to <ON>, proceed as follows:

1 If [Found New Hardware Wizard] or any other dialog boxes appear, click the [Cancel] 

buttons to cancel all the dialog boxes.

2 Set the camera’s power switch to <OFF>.

3 Disconnect the dedicated cable from the camera and computer.

4 Install the Solution Disk software on your computer using the correct installation 

procedure (W-4) and then connect the camera to your computer to complete the 

installation (W-9).

I connected the camera to the computer before 
installing the software

To Display the Device Manager
 Windows XP

� Click the [Start] button � select [Control Panel] � [Performance and Maintenance]

� [See basic information about your computer]. Then select the [Hardware] tab 

and click the [Device Manager] button.

 Windows 2000

� Click the [Start] button � select [Settings] � [Control Panel]. Then double-click the 

[System] icon to open and select the [Hardware] tab and click the 

[Device Manager] button.

 Windows Me and Windows 98 SE

� Click the [Start] button � select [Settings] � [Control Panel]. Then double-click the 

[System] icon to open and select the [Device Manager] tab.
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Uninstalling the Software
 Before beginning the uninstallation, exit all programs you are using and disconnect the 

dedicated cable from your computer.

The following uses the procedures for uninstalling the EOS Viewer Utility as an example for 

uninstalling other programs as well.

 For Windows XP Professional or Windows 2000, log in using computer Administrator 

privileges.

 Before beginning the uninstallation, exit all programs you are using and disconnect the 

dedicated cable from your computer.

 To prevent computer malfunctions, always restart your computer after you have uninstalled 

the software. Re-installing the software without first restarting your computer is likely to 

result in computer malfunctions.

1 Click the [Start] button � select [All Programs] ([Programs] in 

other versions of Windows) � [Canon Utilities] �

[EOSViewerUtility xx] � [EOSViewerUtility Uninstall].

 The EOS Viewer Utility version information is displayed in xx.

2 Proceed with the uninstallation as directed by the on-screen 

messages.

 Software is uninstalled.

Uninstalling the Software
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This section explains how to uninstall the EOS 20D driver. For cameras other than the EOS 

20D, please refer to the Software Instruction Manual supplied with the camera.

 For Windows XP Professional or Windows 2000, log in using computer Administrator 

privileges.

 Before beginning the uninstallation, exit all programs you are using and disconnect the 

dedicated cable from your computer.

 The camera name is shown in the operation screens as “EOS XXX”.

1 Uninstall [EOS XXX WIA Driver] or [EOS XXX TWAIN Driver].

 Your camera model is displayed in EOS XXX.

 For Windows XP or Windows Me, click the [Start] button � select [All Programs] 

([Programs] in Windows Me) � [Canon Utilities] � [EOS XXX WIA Driver] � [WIA 

Driver Uninstall].

 For Windows 2000 or Windows 98 SE, click the [Start] button � select [Programs] �

[Canon Utilities] � [EOS XXX TWAIN Driver] � [TWAIN Driver Uninstall].

2 Proceed with the uninstallation as directed by the on-screen 

messages.

 The driver is uninstalled.

3 Restart the computer

 When the dialog box on the right 

appears, select [Yes, I want to 

restart my computer now.] radio 

button and click [Finish] button.

 When the computer is restarted, 

uninstalling of the driver is 

completed.

Uninstalling the Driver
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1 Installing the Software ...............................................................................M-3

Describes how to install the bundled software.

2 Preparation for Downloading Images .......................................................M-7

Explains how to set up communication mode, and how to connect the camera or a card 

reader (third-party product) to your computer.

3 Working with Images in the EOS Viewer Utility .....................................M-13

Explains how to use the EOS Viewer Utility to download images to your computer, edit 

and save images, and transfer the downloaded images to the retouching software.

4 Remote Shooting in the EOS Capture ....................................................M-53

Describes how to use the EOS Capture for taking shots and specifying the camera 

settings remotely from your computer.

 Remote shooting in the EOS Capture is only available with the EOS 20D.

 The EOS Capture is only compatible with OS X.

5 Troubleshooting and Uninstallation .......................................................M-63

Provides a troubleshooting and describes the software uninstallation procedures.

Index .......................................................................................................................... M-67

Where explanations are common to all operating systems, the screens used in the examples 

are from Mac OS X (10.2). In this chapter, Mac OS X and Mac OS 9.2 are referred to as OS X 

and OS 9 respectively.

M
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System Requirements
The software bundled with this product runs on the systems described below.

 The EOS Capture is only compatible with Mac OS X.

 Because the EOS Viewer Utility for Mac OS 9 has no function for communication with 

the camera, you cannot download images from the camera (M-18) or specify camera 

settings (M-50).

 These software programs are not compatible with UFS (Unix File System) formatted disks 

on Mac OS X.

 A CD-ROM drive is required for installation.

* Only the EOS 20D is compatible with USB 2.0 Hi-Speed.

OS Mac OS X 10.1 to 10.3, Mac OS 9.0 to 9.2

Computer

Macintosh with one of the above OS installed and a USB port as a 

standard feature

* Users of first-generation iMacs require a firmware update.

CPU Power PC

RAM
Mac OS X 10.1 to 10.3: Minimum 256 MB

Mac OS 9.0 to 9.2: Minimum 128 MB

Interface USB 1.1 to 2.0 Hi-Speed*

Hard disk space

EOS Viewer Utility: 100 MB or more

EOS Capture: 300 MB or more

PhotoStitch: 30 MB or more

Display
Resolution: 1024  768 or more

Colors: Thousands or more
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Installing the 

Software

This chapter describes how to install the bundled software.

Installing the Software .............................................................................M-4
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Installing the Software
 Check that your Macintosh complies with the system requirements for the software (M-2) as 

you follow the installation procedure.

1 Start up your Macintosh.

 Quit any programs that are running.

2 Insert the CD (EOS DIGITAL Solution Disk).

 The CD icon appears on the 

desktop.

3 Start installation.

 Double-click the CD icon � the 

[Mac OS X] folder. Then double-

click the icon on the right.

 For OS 9, double-click the [Mac 

OS 9] folder in the CD window and 

then double-click the icon on the 

right.

 The Installer panel appears.

4 Click the [Install] button.

OS X

OS 9
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5 Select [Easy Installation] and click the [Next] button.

6 Check the details of the License Agreement and then click the 

[Agree] button.

7 Check the folder in which the software will be installed and then 

click the [Next] button.

 Installation begins. It takes 

approximately 2 to 3 minutes.
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8 Finish the installation.

 Click the [OK] button.

 After clicking the [OK] button in 

OS 9, the restart dialog box 

appears. Click [Yes] button to 

restart your computer.

9 Click the [Exit] button.

10Once the installation is complete, remove the CD.

 Continue by setting up 

communication mode and 

connecting the camera and 

computer in Chapter 2.
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Preparation for 

Downloading Images

This chapter explains how to set up communication mode, and how to 

connect the camera or a card reader (third-party product) to your computer.

Setting the Communication Mode...........................................................M-8

Connecting the Camera to Your Computer............................................M-9

Using Your Card Reader ........................................................................M-11

Downloading JPEG Images Using the PTP Function in OS X (10.1 or later) .M-12
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Setting the Communication Mode
To communicate with the camera using the software on the Solution Disk, set the camera’s 

communication mode to [Normal].

 The settings on this page are only necessary for the EOS 20D, EOS 10D and EOS 

DIGITAL REBEL/300D DIGITAL.

 With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details on 

changing, see the Canon website.

About the PTP Setting
The PTP function is only available to OS X users. This function provides a simple means of 

downloading JPEG images to your computer. To use this function, set [Communication] to 

[PTP] in step 2 above.

 For more information on using the PTP function to download JPEG images, see 

“Downloading JPEG Images Using the PTP Function in OS X (10.1 or later)” (M-12).

1 Check that the camera is not connected to the computer and then 

set the camera’s power switch to <ON>.

2 Set the camera’s communication mode to [Normal].

 Set [Communication] in menu to 

[Normal].

 With the EOS DIGITAL REBEL/

300D DIGITAL, set 

[Communication] in menu option 

< > to [Normal].

3 Press the < > button to switch the LCD monitor display off 

and then set the camera’s power switch to <OFF>.

 If you set the communication mode to [PTP], the Solution Disk software cannot 

communicate with the camera. When you are using the software, always set the 

communication mode to [Normal].

 When setting the communication mode, always ensure that the camera is not 

connected to the computer beforehand. Setting the communication mode while the 

camera is connected to the computer will cause camera and software malfunctions.
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Connecting the Camera to Your Computer
Before downloading images to your computer or specifying the camera settings, you must 

connect the camera to your computer with the dedicated USB cable. 

You can connect the camera while your computer is running.

 With the EOS Viewer Utility for OS 9, you cannot download images (M-18), specify 

camera settings (M-50), or take shots remotely (M-53) by connecting the camera and 

your computer.

1 Plug the dedicated cable into the computer.

 Plug the cable into the USB port.

 Refer to the computer User’s 

Manual for information on the 

terminal areas.

2 Plug the dedicated cable into your camera.

 Open the cover and connect the 

cable to the < > terminal 

with the [ ] icon facing the front 

of the camera.

 With the EOS D60 and EOS D30, 

connect by aligning the <�> mark 

on the plug with the <�> mark on 

the < > terminal.

3 Set the camera’s power switch to <ON>.

 The camera is now ready to 

communicate with your computer.

 Proceed to Chapter 3 

continuously.
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 Never perform the following operations while the software installed from the Solution 

Disk is running after connecting the camera to the computer as a communications 

error may occur.

• Set the camera’s power switch to <OFF>.

• Open the CF card slot cover.

• Disconnect the dedicated cable, remove the battery, and then remove the AC 

adapter kit (optional) or DC coupler.

• Disconnect the AC adapter’s or DC coupler’s plug or power cord.

Before you perform the operations above, be sure to quit all the software.

 You cannot communicate with the camera when you are displaying images through 

the camera’s LCD monitor. Always connect the camera and your computer after 

turning off the display in the LCD monitor.

 While the camera and your computer are communicating, the camera’s LCD panel 

may blink.

 Use only the dedicated cable.

 Push the plug firmly all the way into the socket. Loose connections can cause faults 

or malfunctions.

 Do not connect the camera to your computer via a hub. If you do so, the camera may 

not operate correctly.

 If you connect multiple USB devices (excluding mouse and keyboard) to your 

computer, the camera may not operate correctly. Disconnect other USB devices from 

your computer and connect only the camera.

 Operation of the Auto power off function will automatically switch the camera off, 

disabling to communicate with your computer. Set the Auto power off function to 

[OFF] in advance. (Refer to “Menu Operations” in the camera’s Instruction Manual.)

 Do not connect more than one camera to the same computer. The connections may 

not operate correctly.

 When unplugging the dedicated cable, be sure to grip the sides of the plug as you pull 

it out.

* If you are using the EOS D60 or EOS D30, pull the plug while pressing the PUSH 

button on it.

 If you do not perform any operation while the camera and computer are connected, a 

confirmation message appears on the computer screen asking whether you wish to 

continue communicating with the camera for some computer systems. If you do not 

perform any operation even after this message appears, the communication with the 

camera is terminated. To re-establish the communication, press the shutter button 

down halfway or set the camera’s power switch to <OFF> and then back to <ON>.

 Do not put your computer to sleep while it is connected to the camera.

If your computer goes into the sleep mode, never disconnect the dedicated cable 

while your computer is still in sleep mode. Always wake your computer up while it is 

connected to the camera. On some types of computer, disconnecting the dedicated 

cable while your computer is in sleep mode could prevent the computer from waking 

up correctly. Refer to the computer User’s Manual for more information on sleep 

mode.
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Users with a third-party card reader can download images directly from a memory card to the 

computer.

When you connect the camera and your computer, it is recommended that you use an 

AC adapter kit (optional) with the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D 

DIGITAL, and the DC coupler supplied with the EOS D60 and EOS D30.

1 Remove the memory card from the camera.

2 Load the card into the card reader.

 Proceed to Chapter 3 

continuously.

For information on connecting the card reader to your computer, refer to the card reader 

User’s Manual.

Using Your Card Reader
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Downloading JPEG Images Using the PTP Function in OS X (10.1 or later)
Users of OS X (version 10.1 or later) can use the PTP (Picture Transfer Protocol) function. The 

PTP function allows you to download JPEG images saved on a memory card in the camera to 

your computer without having to start the software provided on the Solution Disk.

 This function is available with the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D 

DIGITAL only.

 With the EOS 10D, you must change the firmware to version 2.0.0 or later. For details on 

changing, see the Canon website.

1 Set the camera’s communication mode to [PTP] (M-8).

 Set [Communication] in menu to 

[PTP].

 With the EOS DIGITAL REBEL/

300D DIGITAL, set 

[Communication] in menu option 

< > to [PTP].

 Press the < > button to 

clear the LCD monitor display.

 When you have finished, set the 

camera’s power switch to <OFF>.

2 Connect the camera to the computer and set the camera’s power 

switch to <ON> (M-9).

 Image Capture or iPhoto starts up.

 You can specify which software 

starts up in Image Capture.

3 Download the images as directed.

 Follow the instructions in the on-screen messages to download the JPEG images.

Refer to the separate “Notes on the PTP Function” for details when the downloaded 

image does not display correctly or the image cannot be downloaded.

 To specify the software that will start up when the camera is connected to the 

computer, start up Image Capture and select [Preference] in the [Image Capture] 

menu. In the [Image Capture Preference] dialog box, select the application in the 

[When a camera is connected, open] list box.

 Image Capture and iPhoto are software bundled with OS X. For detailed information 

on using these applications, refer to the Help provided in the respective application.
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Working with Images in 

the EOS Viewer Utility

This chapter explains how to use the EOS Viewer Utility to download images 

to your computer, edit and save images, and transfer the downloaded 

images to the retouching software.

For more information on the restrictions of the EOS Viewer Utility, refer also to the 

source listed below.

ReadMe: Double-click the [Canon Utilities] folder � the [EOS Viewer Utility] folder 

� [ReadMe].

Starting the EOS Viewer Utility.... M-14

Downloading Images.................... M-18

Handling the Folders .................... M-20

Memory Card Folder Structure and File 

Names ........................................ M-20

Registering Frequent Use Folder ...M-21

Selecting the Image Display Mode ...M-22

Main Window (Thumbnail Display)...M-22

Preview Window Display............. M-22

Selecting the Display Size .......... M-24

Checking the AF Point ................ M-24

Selecting Images .......................... M-25

Selecting Images in the Main Window ..M-25

Selecting Images in the Preview Window .. M-25

Attaching Check Marks to Images...M-26

Selecting Images by Condition ... M-26

Bringing/Sending the Main Window to 

the Front/Back of Window Stack ...M-27

Equalizing the Display Sizes of the 

Preview Window ......................... M-27

Editing Images .............................. M-28

Protecting Images ....................... M-28

Rotating Images.......................... M-28

Deleting Images.......................... M-29

Checking the Image Information and 

Entering Comments .................... M-29

Printing Images............................. M-30

Editing RAW Images .................... M-31

Processing RAW Images............ M-31

Specifying the Processing Parameters ..M-32

Adjusting the Brightness (Digital 

Exposure Compensation) ........... M-33

Adjusting the White Balance....... M-34

Selecting the Contrast ................ M-37

Adjusting the Color ..................... M-38

Specifying the Color Space ........ M-40

Selecting the Sharpness............. M-40

Saving Images .............................. M-41

Extracting JPEG Images from RAW 

Images ........................................ M-43

Transferring Images to Retouching 

Software ........................................ M-44

Specifying the Preferences ......... M-46

Setting the IPTC Information ....... M-47

Specifying the Camera Settings....M-50

Merging Images with the PhotoStitch...M-52
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Starting the EOS Viewer Utility

1 Connect the camera to your computer (M-9).

2 Double-click the [Canon EOS Viewer Utility] icon on the desktop.

 The main window appears.

 You can also start the EOS Viewer Utility by double-clicking the [Canon Utilities] 

folder � the [EOS Viewer Utility] folder � the [EOS Viewer Utility] icon.
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Main window

 For OS X, to quit the EOS Viewer Utility, select the [EOS Viewer Utility] menu � [Quit EOS 

Viewer Utility].

 For OS 9, to quit the EOS Viewer Utility, select the [File] menu � [Quit].

Main window tool bar

Path display

Displays the folder path 
selected in the Tree View Area.

Image display areaStatus bar

Comment input box (M-29)

Bookmark area (M-21)

Detailed Information display area (M-29)

Tree View Area (M-18)

RGB value display

When you move the cursor over an image, the 
coordinates of the cursor position and its RGB values 
(8-bit conversion) are shown here.

Histogram

Shows the distribution of the brightness of an image.
Selecting the tab switches the histogram display 
values between Brightness and RGB.

Image information display area
Displays basic shot information.
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Main window tool bar

Show/Hide Tree View button

Shows/hides the Tree View Area.

Display Size 
list box (M-24)

Rotate right 90 degrees button (M-28)

Remove protect button 
(M-28)

Remove Check 
Mark button (M-26)

Transfer images 
button (M-44)

protect button (M-28)

Erase images 
button (M-29)

Save File button 
(M-41)

Select Image button 
(M-26)

Show/Hide Thumbnail Frames button

Shows/hides the information display frame 
of thumbnail images.

Add Check Mark button (M-26)

Rotate left 90 degrees button (M-28)

Show/Hide Image Information button
Shows/hides the histogram, image information 
display area, Detailed Information display area, 
and comment input box.

EOS Capture 
button (M-54)

IPTC information button 
(M-47)

Play sound button
*This button does not work with 
the camera you are using.

Window button 
(M-27)
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RAW adjustment tool palette

 When you select a RAW image, the name of the camera on which the selected RAW image 

was taken and its settable processing parameters are displayed.
*1 Not displayed with the EOS 10D and EOS DIGITAL REBEL/300D DIGITAL.
*2 Not displayed with the EOS D60 RAW images.
*3 Not displayed with the EOS D30 RAW images.

 Where you have selected a JPEG image or where you have selected a TIFF or JPEG 

image converted from a RAW image with the EOS Viewer Utility, nothing is displayed 

on the RAW adjustment tool palette and the image cannot be edited.

 Where you have selected a RAW image saved on the memory card inside the 

camera, nothing is displayed on the RAW adjustment tool palette and the image 

cannot be edited. Work with the images saved on your computer from the memory 

card.

 The settings used when shots were taken are displayed in italic or bold type in the list box.

 If the RAW adjustment tool palette is hidden, select the [View] menu � [Tool palette] to 

show it.

B/W radio button (M-38)*1, 2, 3

Digital Exposure 

Compensation slider (M-33)*3

White Balance list box 
(M-34, M-35)

Contrast list box (M-37)

Sharpness list box (M-40)

Click White Balance button 
(M-36)

Color Space list box (M-40)*2, 3

Color Tone list box (M-38)*3

Color Saturation list box (M-38)

Preview checkbox (M-32) Update button (M-32)

Reset to Shot Settings button 
(M-32)

Displays the name of the 
camera on which the selected 
RAW images were taken.

Standard radio button 

(M-38)*1, 2, 3

White Balance Compensation 

slider (M-37)*1, 2, 3

Color Temp. input box (M-35)*2, 3

Toning Effect list box (M-39)*1, 2, 3

Filter Effect list box (M-39)*1, 2, 3
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Downloading Images
The procedure below describes how to download (copy) the images saved on a memory card 

in the camera to your computer, and display them on the main window. You can download 

images in the Tree View Area.

 This function is only available with the EOS Viewer Utility for OS X. 

With the EOS Viewer Utility for OS 9, you cannot download images saved on a memory 

card inside the camera. Download images to your computer by either using the EOS Viewer 

Utility for OS X or by using a third-party card reader.

1 Create a folder to which images will be downloaded.

 From the menu that is displayed 

by clicking on the destination 

folder while pressing the <control> 

key, select [New folder] to create a 

folder and enter a name for the 

folder. (Enter [Photo] in the folder 

name field here as an example.)

2 Display a folder to be copied.

 Double-click the camera icon �

the [DCIM] folder.

 The [xxxCANON] folder is 

displayed. (“xxx” represents a 

number 100 to 999.)

3 Copy the folder to the hard disk.

 Drag and drop the [xxxCANON] 

folder to the destination folder.

 The [xxxCANON] folder is saved 

on your computer. 
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Supported Image Formats
The images below can be displayed with the EOS Viewer Utility.

* Includes TIFF and JPEG images converted from RAW images and saved with the EOS 

Viewer Utility.

4 Click the copied folder.

 The images in the folder are 

displayed.

 Before disconnecting the camera 

from the computer, quit the EOS 

Viewer Utility, set the camera’s 

power switch to <OFF>, and then 

disconnect the dedicated cable.

 You cannot display images in the preview window (M-22) or edit RAW images (M-31) 

saved on a memory card in the camera directly. Work with the images saved on your 

computer from the memory card.

 For displaying images saved in a third-party card reader, follow the same procedure 

to download the target folder to your computer.

Image Format File Extension

RAW images taken with the EOS-1D Mark II and the EOS 20D .CR2

RAW images taken with the EOS-1Ds and the EOS-1D .TIF

RAW images taken with the EOS 10D, DIGITAL REBEL/300D DIGITAL, 

D60 and D30
.CRW

JPEG images conforming with the Exif 2.2, 2.21 standard* .JPG/.JPEG

TIFF images conforming with the Exif standard* .TIF/.TIFF

 Images that cannot be displayed appear as a question mark [?].

 The images that are processed on your computer after being shot or the images 

whose file name is changed may not be displayed properly.

 You cannot use the camera while displaying images on the camera.

 By setting [Auto rotate] setting to <ON> for the camera with this function, images shot 

in a vertical position are automatically displayed vertically.

 If the selected folder contains a large number of images, there may be a short delay 

before the images appear.
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Handling the Folders
You can handle the folder on the menu that appears by clicking on the folder while holding 

down the <control> key.

 The “xxx” in the folder names represent a number between 100 to 999.

 The “YYYY” in the file names represent a number between 0001 to 9999.

Click on the folder while holding down the <control> key, and then 

select an option from the menu that appears.

You can drag and drop folders from the Tree View Area to the other folders.

The file name of images shot with the EOS 20D is “_MG_” (the first character is an 

underscore) when Adobe RGB is set.

Opens the selected folder.

Creates a new folder. Note that you 
cannot create a new folder in the 
memory card in the camera.

Allows you to change the folder name.

Memory Card Folder Structure and File Names

xxxCANON

IMG_YYYY.JPG: JPEG image

CRW_YYYY.CRW: EOS 10D, EOS DIGITAL REBEL/300D 
DIGITAL, EOS D60, EOS D30 RAW images

CRW_YYYY.THM: Image for displaying the camera’s index

DCIM

CANONMSC

MISC

The folder that holds the image control files in the DCIM folder.

The folder created when DPOF settings are set.
It holds the DPOF settings files.

IMG_YYYY.CR2: EOS 20D RAW image
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You can register frequent use folders as bookmark folders.

1 Display a folder to be registered (M-18).

2 Register a folder as a bookmark folder.

 Drag and drop the folder to be 

registered as shown on the right.

 The folder icon appears in the 

Bookmark area when it is 

registered.

 To delete the registered folder, 

click the folder while holding down 

the <control> key and select 

[Delete] from the menu that 

appears.

 You can also reorder the folders in the Bookmark area by dragging and dropping them.

 When you delete the registered folder, it just disappears from the Bookmark area. 

The actual data of the folder and the images in that folder will not be deleted.

Registering Frequent Use Folder
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Selecting the Image Display Mode
You can select the display size and method of images.  

Various information can be displayed with images. 

Double-clicking an image displayed on the main window can enlarge the image. 

When you change the processing parameters of RAW images, use this window.

 The preview window can display a maximum of six previews.

 A low resolution image is displayed first in the preview window, and then it changes to a high 

resolution image.

Preview window

Main Window (Thumbnail Display)

Digital exposure 
compensation value (M-33)

Protect mark (M-28)
This mark is displayed on protected images.

Recording quality

The [RAW] and [RAW+JPEG] 
symbol are displayed for RAW 
and RAW+JPEG images 
respectively. No symbol is 
displayed for JPEG images. 
* Only images taken with the EOS 

20D in RAW+JPEG format 
display the [RAW+JPEG] 
symbol.

File name or shooting date/time

The items selected in the [Image Lower 
Display Item] list box in the [Preferences] 
dialog box (M-46) are displayed.

Check mark (M-26)

This mark is displayed on images 
for which a check mark was 
attached.

Display number 
Numbers are assigned 
sequentially to the displayed 
images starting with the first 
image.

Preview Window Display 

RAW adjustment tool palettePreview tool bar
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Preview tool bar

You cannot display images in the preview window or edit RAW images (M-31) saved on 

a memory card in the camera directly. Work with the images saved on your computer 

from the memory card.

 For some images, it may take some time to change to the high resolution image.

 You can set the image displayed in the preview window to RAW image or the 

simultaneously recorded JPEG image (M-46).

Window button (M-27)

Display Size 
list box (M-24)

Remove Check Mark button (M-26)

Remove protect button (M-28)

Save File button (M-41)

Erase images 
button (M-29)

Transfer images button 
(M-44)

Protect button (M-28)

Add Check Mark button (M-26)

Rotate left 90 degrees button (M-28)
Select Previous 
Image button 
(M-25)

IPTC information button (M-47)

Display AF point button (M-24)

*Only compatible with EOS 20D, EOS 
10D and EOS DIGITAL REBEL/300D 
DIGITAL images.

Show/Hide Image 
Information button

Shows/hides the 
histogram, image 
information dispaly area, 
Detailed Information 
display area, and 
comment input box.

Rotate right 90 degrees button (M-28)

Select Next Image 
button (M-25)

Play sound button

*This button does not work with the camera you are using.

JPEG preview button 

Changes the image displayed in the preview window to a RAW or JPEG image.
*Only compatible with EOS 20D RAW+JPEG images and EOS 10D, EOS DIGITAL 
REBEL/300D DIGITAL and EOS D60 RAW images.
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M-24

The AF point used when the shot was taken can be displayed.

 This function is only available with images of the EOS 20D, EOS 10D and EOS 

DIGITAL REBEL/300D DIGITAL.

Select a display size from the list box.

 In the main window, the available 

image sizes are [Small] (64  42

pixels), [Medium] (100  66

pixels), and [Large] (160  106

pixels).

 In the preview window, the 

available image sizes are [Fit to 

window] and [100%].

 When you select [100%], you can 

change the display position by 

dragging the image.

1 Display the image in the preview window (M-22).

2 Click the [Display AF point] button.

 The AF point is displayed.

 Clicking the button again hides the 

AF point.

When the shot was taken with automatic AF point selection, multiple active AF points 

might be displayed.

Selecting the Display Size

Main window

Preview window

Checking the AF Point
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Selecting Images

Click the target image.

 The frame around the selected 

image is colored.

 To select multiple images, hold 

down the <shift> key and click the 

images.

 To select sequential images, click 

the first image and then hold down 

the <option> + <shift> keys and 

click the last image.

Alternatively, you can use the arrow keys (����) on the keyboard to select images.

Click the target image.

 The selected image is displayed 

on the top window.

 When only one preview window is 

displayed, you can click the 

[Select Previous Image] button or 

the [Select Next Image] button to 

select the image to be displayed.

Selecting Images in the Main Window

Selecting Images in the Preview Window
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You can attach a check mark to the RAW image, allowing you to select images more easily.

This feature allows you to select multiple images in a single operation using conditions.

Click the [Add Check Mark] button.

 When the check mark is placed, 

the [ ] icon appears in the frame 

of the image.

 Clicking the [Remove Check Mark] 

button removes the [ ] icon from 

the frame of the image, and 

erases the check mark.

You cannot attach the check mark for any images other than RAW images.

 When multiple RAW images are selected, the check mark is attached to all the 

selected RAW images.

 Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

Click the [Select Image] button and select the condition from the 

menu that appears.

 Only images that meet the 

condition are selected.

Attaching Check Marks to Images

Selecting Images by Condition
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You can set all the preview windows to the same size.

Select [Move main window to front] or [Move main window to 

back] from the menu that appears by clicking the [Window] 

button.

 The main window is brought/sent 

to the front/back of window stack.

1 Select the image whose size is the desired size (M-25).

2 Click [Standardize preview window size] from the menu that 

appears by clicking the [Window] button.

 All the displayed preview windows 

are set to the same size as the 

selected image.

Bringing/Sending the Main Window to the 
Front/Back of Window Stack

Equalizing the Display Sizes of the 
Preview Window
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Editing Images
You can edit all the images that can be displayed in the EOS Viewer Utility.

You can protect important images to prevent them from being accidentally deleted.

You can rotate a selected image by 90-degree increments left or right.

When multiple images are selected, the edits are applied to all the selected images.

Click the [protect] button.

 When the image is protected, the  

[ ] icon appears in the frame of 

the image.

 Clicking the [Remove protect] 

button removes the [ ] icon from 

the frame of the image, and clears 

the protection.

 The [ ] is automatically displayed for images that were protected on the camera.

 Protection only prevents images from being deleted. Other types of image operations 

can still be performed for protected images.

 Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

Click the [Rotate right 90 degrees] or [Rotate left 90 degrees] 

button.

 The image rotates 90 degrees in 

the selected direction.

 By setting [Auto rotate] setting to <ON> for the camera with this function, images shot 

in a vertical position are automatically displayed vertically.

 If a rotated image is displayed in another application, the image may not appear 

rotated.

 Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

Protecting Images

Rotating Images



Editing Images

M-29

M

3

W
o

rk
in

g
 w

it
h

 I
m

a
g

e
s
 i
n

 t
h

e
 E

O
S

 V
ie

w
e

r 
U

ti
lit

y

You can move unnecessary images to the Trash on your computer and delete them.

You can check the information recorded with images and input comments.

1 Click the [Erase images] button.

 The images are moved to the 

Trash.

2 Select the [Finder] menu on the desktop � [Empty Trash].

 For OS 9, select the [Special] menu � [Empty Trash].

 The images are deleted.

 Images that you deleted by selecting [Empty Trash] in step 2 cannot be restored. 

Check carefully before deleting images.

 Protect important images (M-28) to prevent them from being accidentally deleted.

Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

Detailed Information display area
 The shooting information is displayed. 

The number of items displayed differs depending on the camera settings.
 You can copy the information as text data and paste it into another application.
 Clicking the [�] button can hide the Detailed Information display area.

You cannot insert a hard return in the comment input box.

When multiple images are selected, the information from the image selected last is 

displayed.

Deleting Images

Checking the Image Information and Entering Comments

Comment input box

You can use this box to type in a 
comment up to 120 characters long.
Type in your comment and press the 
<return> key.
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Printing Images
You can use the EOS Viewer Utility to print images in index format.

1 Select images to be printed in index format (M-25).

2 Select the [File] menu � [Print Index].

 The Printer Setup dialog box appears.

3 Select the printer to be used, specify the print settings and print 

images.
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Editing RAW Images
You can specify the processing parameters for RAW images so that the RAW images are 

optimized for their intended purpose.

RAW images are processed based on the settings specified on the camera (including the 

processing parameters and white balance) and then displayed on the computer.

 When the following operations are performed, RAW images are processed and displayed:

• When the preview window is switched from the main window

• When the processing parameters are specified on the preview or main window

• When the image is converted to the TIFF or JPEG format and saved

• When the image is transferred to the specified retouching software

When the images are processed, it takes a while to display them.

 Approximate processing times

• The processing times given here are only approximations. Actual processing times 

vary widely depending on the images and the computer system.

• Processing times are based on Canon testing standards.

(OS: OS X 10.2; CPU: Power PC G5 1.6 GHz; RAM: 256 MB)

• The processing time in the retouching software includes starting up time of the retouching 

software (when using Adobe Photoshop 7.0).

Operation Details

Camera Model

Switching from the main 

window to the preview window

Transferring an image to the 

specified retouching software

EOS 20D Approx. 5 sec. Approx. 45 sec.

EOS 10D Approx. 4 sec. Approx. 35 sec.

EOS DIGITAL REBEL/

300D DIGITAL
Approx. 4 sec. Approx. 35 sec.

EOS D60 Approx. 4 sec. Approx. 30 sec.

EOS D30 Approx. 4 sec. Approx. 25 sec.

You cannot display images in the preview window (M-22) or edit RAW images saved on 

a memory card in the camera directly. Work with the images saved on your computer 

from the memory card.

Processing RAW Images
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 You can specify the processing parameters in the RAW adjustment tool palette.

 This processing applies the specified parameters virtually and does not affect the original 

RAW images in any way. Consequently, you can redo the processing as often as you like 

with different parameters and then reset the modified parameters to the settings used when 

the shot was taken.

 Linear processing can be specified when an image is saved (M-41) or is transferred to 

retouching software (M-44).

 The procedure below is an operating method in the preview window, but you can set 

processing parameters with the same operation in the main window also. However, in the 

main window, you cannot click the [Preview] checkbox and the processing parameters you 

have set are immediately reflected in the image.

1 Display the RAW image in the preview window (M-22).

 If the RAW adjustment tool palette is hidden, select the [View] menu � [Tool palette] 

to show it.

2 Specify the processing parameters (M-33 to M-40).

 Clicking the [Reset to Shot Settings] button restores the settings to the values used 

when the shot was taken.

 If you click the [Preview] checkbox, the specified processing parameters are applied 

to the RAW images

3 Click the [Update] button.

 The RAW images are processed 

according to the specified 

processing parameters.

4 Save (M-41) or transfer images (M-44).

The processing parameters set with the EOS Viewer Utility in the RAW images of a 

camera other than the EOS 20D are cancelled when you quit the EOS Viewer Utility, and 

are reset to the processing parameters for when shooting. Either convert the RAW image 

specified with the processing parameters to a TIFF or JPEG image and save (M-41), or 

transfer to retouching software (M-44) and save.

When multiple images are selected in the main window, the specified processing 

parameters are applied to all the selected RAW images.

Specifying the Processing Parameters
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You can adjust the brightness of an image in the range of +/–2 stops in 0.1-stop increments.

 This function is only available with RAW images of the EOS 20D, EOS 10D, EOS 

DIGITAL REBEL/300D DIGITAL and EOS D60.

Drag the slider left or right to adjust the brightness. 

 The adjusted value is specified in 

the RAW adjustment tool palette.

Adjusting the Brightness (Digital Exposure Compensation)

Adjustment value set with the slider.
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You can adjust the white balance in the images. 

Selecting the White Balance
You can select the white balance that is the closest to the light source when shots were taken.

Select the white balance from the list box.

 [Shade] and [Color Temp.] are not 

displayed for the EOS D60 and 

EOS D30 RAW images.

White Balance Details
Color Temp.

K (Kelvin)

Auto Automatically adjusts the white balance. Approx. 3000 to 7000

Daylight For sunny daylight outdoors. Approx. 5200*

Shade For shaded areas outdoors. Approx. 7000

Cloudy For cloudy or hazy days and during sunset. Approx. 6000

Tungsten For tungsten (light bulb) light. Approx. 3200

Fluorescent For white fluorescent light. Approx. 4000

Flash When flash is used. Approx. 6000

Color Temp.
You can manually set color temperature for 

2800 to 10000K (in 100K increments) (M-35).
Approx. 2800 to 10000

* Approximately 5500 with the EOS D30 RAW images.

 The selected white balance is specified in the RAW adjustment tool palette.

Adjusting the White Balance
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Specifying the Color Temperature
You can specify the color temperature to adjust the white balance.

 This function is only available with RAW images of the EOS 20D, EOS 10D and EOS 

DIGITAL REBEL/300D DIGITAL.

1 Select [Color Temp.] from the list box.

2 Enter a color temperature.

 Enter the color temperature in the 

[Color Temp.] input box in the 

range of 2800K to 10000K (in 

100K increments).

 The entered color temperature is 

specified in the RAW adjustment 

tool palette.
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Click White Balance Function
Makes white the standard for the part you have selected and automatically adjusts the white 

balance.

1 Click the [Click White Balance] button.

 When you move the cursor over 

the image, the cursor [ ] 

changes to [ ].

2 Click the part where white is to be the standard.

 The white balance is adjusted so that the point clicked appears white.

 When you use Click White Balance Function, even though you do not click the 

[Preview] checkbox, the adjusted white balance is applied to the images.

 When you use Click White Balance Function, [White Point] is displayed in the [White 

Balance] list box.

 You can adjust by selecting the neutral gray parts of the image.
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Correcting the White Balance
You can correct the standard color temperature of the white balance. By using this function, you 

can obtain the effectiveness similar to the color temperature converting filter or color 

compensating filter (third-party product). The range of compensation is 9 levels for each color.

This function is especially useful for users who understand the role and effect of the color 

temperature converting filter or color compensating filter.

 This function is only available with the EOS 20D RAW images.

You can adjust the contrast of an image.

Drag the slider left and right to adjust the white balance.

 The corrected value is specified in the RAW adjustment tool palette.

One level of blue/amber hue is equal to five mireds of the color temperature converting 

filter. (Mired: the unit of the density of the color temperature converting filter)

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

 [Mid.Low] and [Mid.High] are not 

displayed for the EOS D60 and 

EOS D30 RAW images.

Correction value when shooting.

The corrected value specified using the slider.

Dragging the slider toward B-side adds 
blue hue, and toward A-side, amber hue.

Dragging the slider toward G-side adds 
green hue, and toward M-side, magenta hue.

Selecting the Contrast
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Select the color adjustment options with the radio buttons to make each type of adjustment.

 Selecting of color adjustment options is only available with EOS 20D RAW images.

Selecting the Color Saturation

Adjusting the Color Tone
 This function is only available with the EOS 20D, EOS 10D, EOS DIGITAL REBEL/

300D DIGITAL and EOS D60.

Select the [Standard] radio button or the [B/W] radio button.

 With the radio button you have 

selected, you can make the 

following color adjustments. Also, 

if you select [B/W], the image will 

become monochrome.

[Standard]: Color Saturation, Color 

Tone

[B/W]: Filter Effect, Toning Effect

 See the section below for 

adjustment methods.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

 [Mid.Low] and [Mid.High] are not 

displayed for the EOS D60 and 

EOS D30 RAW images.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

 The more negative the value, the 

redder the image becomes, and 

the more positive the value, the 

more yellow.

 [–2] and [+2] are not displayed for 

the EOS D60 RAW images.

Color Adjustment
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Filter Effect
 This function is only available with EOS 20D RAW images.

Toning Effect
 This function is only available with EOS 20D RAW images.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.
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You can set the color space of the images you have taken.

 This function is only available with RAW images of the EOS 20D, EOS 10D and EOS 

DIGITAL REBEL/300D DIGITAL.

You can adjust the edge sharpness of an image.

Select a setting from the list box.

 The selected setting is specified in 

the RAW adjustment tool palette.

 The specified color space is recorded in the ICC profile attached to a TIFF image 

converted and saved from a RAW image (M-41).

 An ICC profile contains color information, such as color properties and color spaces 

of devices which are authorized by International Color Consortium (ICC). With this 

ICC profile, many color management systems can minimize the color differences 

between devices.

Select a setting from the list box.

 Higher values give higher levels of 

edge sharpening.

 [Mid.Low] and [Mid.High] are not 

displayed for the EOS D60 RAW 

images.

 [Off], [Mid.Low] and [Mid.High] are 

not displayed for the EOS D30 

RAW images.

 The selected setting is specified in 

the RAW adjustment tool palette.

Specifying the Color Space

Selecting the Sharpness
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Saving Images
You can convert and save RAW images to TIFF or JPEG images, and save JPEG images as 

another name. When you convert RAW images to the TIFF format and save them, the specified 

color space data (M-40) is attached to each of images as the ICC profile automatically.

1 Select images to be saved (M-25).

2 Click the [Save File] button and select [Convert and save in file] 

from the menu that appears.

 The [Save File] dialog box 

appears.

3 Specify the settings and click the [OK] button.

 The images are saved in the 

selected folder.

 When you convert RAW images to the TIFF images and save them, the ICC profile is 

attached to each of images automatically. An ICC profile contains color information, 

such as color properties and color spaces of devices which are authorized by 

International Color Consortium (ICC). With this ICC profile, many color management 

systems can minimize the color differences between devices.

 Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

Restores the settings to their 
original ones and closes the 
[Save File] dialog box.

Applies the settings 
and saves the image.
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The image is saved as a new image in the same folder as the selected image.

Allows you to specify the folder 
in which the image will be saved.

Select a setting for [Quality] (compression ratio) when you have selected [JPEG] 
from the list box, from [4 (Highest image quality)] through [1 (High compression 
ratio)]. Higher values give higher quality of the JPEG image.

Click this checkbox to also save JPEG 
images taken in RAW+JPEG format.
*This function is only available with 
EOS 20D RAW+JPEG images.

If some of the images to be saved are RAW images, select [Do not convert], [JPEG], or [TIFF] for the 
conversion format. If you select [TIFF], you can select the number of bits used when you save images from 
[8bit/ch], [16bit/ch] and [16bit/ch linear]. If you select [JPEG], the images are saved in the [8bit/ch] format.
The extensions used for the saved files are shown below.

When the [Save in following specified folder] radio button has been selected, this 
button allows you to specify the folder in which the image will be saved. The 
name of the destination folder is displayed next to the [Browse] button.

Specify the resolution for 
saving images in a range 
of 10 to 2000 pixels/inch.

Conversion Format Extension

Do not convert

EOS 20D .CR2

EOS 10D, EOS DIGITAL REBEL/300D 
DIGITAL, EOS D60, EOS D30

.CRW

JPEG (8bit/ch) .JPG

TIFF (8bit/ch) .TIF

TIFF (16bit/ch, 16bit/ch linear) .TIF
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 A JPEG image simultaneously recorded with a RAW image can be extracted and saved.

 This function is only available with RAW images of the EOS 10D, EOS DIGITAL 

REBEL/300D DIGITAL and EOS D60.

 The EOS DIGITAL REBEL/300D DIGITAL and EOS D60 simultaneously record a Middle/

Fine JPEG image and the EOS 10D simultaneously records the JPEG image set up in the 

camera.

 The contents that can be set are the same as [Save folder] and [File Name] of “Saving 

Images” (M-41).

1 Select the RAW image from which a JPEG image is to be 

extracted (M-25).

2 Click the [Save File] button and select [Extract & Save JPEG] from 

the menu that appears.

 The [Extract & Save JPEG] dialog 

box appears.

3 Specify the desired settings and click the [OK] button.

 The JPEG image is saved in the selected folder.

This is text inserted before the file number. You can enter up to 12 characters. 
When you enter text, an example appears in the [Example] field below the text box.

*This button does not work with the camera you are using.

Enter the number of digits in the sequential 
number that attaches to the file and the 
starting number used. A maximum of 9 digits 
can be specified.

Click this checkbox when saving the file after converting a RAW image to a JPEG image 
or TIFF image adds one of the following at the end of the file name.

Conversion Format Conversion Format Name

JPEG RJ

TIFF (8bit/ch) RT8

TIFF (16bit/ch, 16bit/ch linear) RT16, RT16L

Click this checkbox when you want to save 
the image without changing the name.

Extracting JPEG Images from RAW Images
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Transferring Images to Retouching Software
You can transfer the images displayed in the EOS Viewer Utility to retouching software.

The descriptions given here use Adobe Photoshop 7.0, as an example.

 In order to transfer images, you will need retouching software such as Adobe 

Photoshop.

 Be sure to specify the image transfer settings before transferring images.

1 Click the [Transfer images] button.

 The [Transfer Images] dialog box 

appears.

2 Click the [Browse] button.

 The [Select application] dialog box 

appears.

3 Select the retouching software (Photoshop 7.0) to which the 

image will be transferred.

 Select the drive in which 

Photoshop 7.0 is installed �

[Applications] folder � [Adobe 

Photoshop 7] folder � [Adobe 

Photoshop 7]. Then click the 

[Choose] button.

 Photoshop is specified and the 

dialog box closes.
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4 Select the radio button and then select a folder in which the 

images to be transferred will be saved.

5 Specify [Output settings] and [File Name] and then click the [OK] 

button.

 See “Saving Images” (M-41) for the procedure for specifying [Output settings] and 

[File Name]. 

 Photoshop starts up and displays the transferred images.

 The transferred images are saved in the folder that you have selected in step 4.

 It is recommended that you should use the retouching software (third-party product) 

that supports 16-bit images for the one to be specified for the transfer image function.

 When you convert RAW images to the TIFF format and save them, the specified color 

space data (M-40) is attached to each of the images as the ICC profile automatically.

 Alternatively, you can perform the same operation using the menu that appears by 

holding down the <control> key and clicking.

The images to be transferred are saved 
as new images in the same folder.

Click the [Browse] button and then select a folder in which the images 
to be transferred will be saved.
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Specifying the Preferences
You can specify the preferences for the EOS Viewer Utility.

1 Select the [EOS Viewer Utility] menu � [Preferences].

 The [Preferences] dialog box appears.

2 Specify the settings and click the [OK] button.

 The settings are applied and the [Preferences] dialog box closes.

You can also select in the preview window whether the image displayed is the RAW 

image or the simultaneously recorded JPEG image (M-22).

Allows you to select whether the folder that was open the last time is displayed or 
the specified folder is always displayed when the EOS Viewer Utility starts up.

Select the information to be displayed below images 
from [File Name] and [Shooting Date/Time].

Restores the settings to 
their original ones and 
closes the [Preferences] 
dialog box.

Applies the settings and closes 
the [Preferences] dialog box.

Restores the settings to 
the default settings.

Displays the monitor profile set in the operating system. 
Settings are made in the operating system.

Select whether the image displayed in the preview window is the RAW image or the 
simultaneously recorded JPEG image.
* Only compatible with EOS 20D RAW+JPEG images and EOS 10D, EOS DIGITAL 

REBEL/300D DIGITAL and EOS D60 RAW images.
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Setting the IPTC Information
IPTC stands for International Press Telecommunications Council and refers to a standard for 

communications and information exchange tags attached to images. The standard was 

established by newspaper and communications companies to allow problem-free transmission 

of images.

You can attach this IPTC information to JPEG images, or to TIFF and JPEG images that were 

converted from RAW images and saved with the EOS Viewer Utility. You can also save the 

IPTC information on your computer, and then load the saved information and apply it to other 

images.

1 Select a JPEG or a TIFF image (M-25).

2 Click the [IPTC information] button.

 The [IPTC information] dialog box 

appears.

3 Enter information (M-48, M-49).

 Select any of [IPTC-1], [IPTC-2], or [IPTC-3] tab to display the tab sheet, and enter 

the information.

 The entered IPTC information can be saved on the dialog box that appears by 

clicking the [Save As] button.

 The saved IPTC information can be loaded on the dialog box that appears by clicking 

the [Read] button.

4 Click the [Save] button.

 The specified IPTC information is applied to the image.

5 Click the [OK] button.

 The [IPTC information] dialog box closes.

IPTC information settings data saved on your computer is compatible with the EOS 

Viewer Utility for both Windows and Macintosh.
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Settings on the [IPTC-1] tab sheet 

IPTC-2 tab IPTC-3 tabIPTC-1 tab

Loads the IPTC information saved on your computer.

Saves the entered IPTC information on your 
computer.

Cancels the entered IPTC information.

Displays the image for which you will enter 
the IPTC information.

When multiple images are selected, 
this button displays the IPTC 
information for the previous image.

When multiple images are selected, 
this button displays the IPTC 
information for the next image.

Displays the image No. in a sequence.

Closes the [IPTC information] dialog box.

Displays the IPTC information entered before 
the [Previous] or [Next] button was clicked.

Applies the entered IPTC information to the image.

You can enter up to 64 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 2000 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.
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Settings on the [IPTC-2] tab sheet 

Settings on the [IPTC-3] tab sheet 

You can enter up to 10 characters.

Select [Highest Priority (=1)], [Normal (=5)], or 
[Low Priority (=8)] from the list box.

You can enter up to 256 characters.

You can enter up to 8 characters.

You can enter up to 11 characters.

You can enter up to 32 characters.

You can enter up to 3 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.

You can enter up to 256 characters.

You can enter up to 32 characters.

You can enter up to 32 characters.
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Specifying the Camera Settings
You can specify the owner’s name and date/time in the camera.

 This function is only compatible with the EOS Viewer Utility for OS X.

1 Connect the camera to your computer (M-9).

2 Start up the EOS Viewer Utility (M-14).

3 Select the [Options] menu � [Camera Settings].

 The [Camera settings] dialog box appears.
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4 Specify the settings.

 With the EOS D30, the [Parameters] button is displayed. For details on [Parameters], 

refer to the Software Instruction Manual supplied with your camera.

5 Click the [OK] button.

 The settings are applied and the [Camera settings] dialog box closes.

Formatting a memory card deletes all the data on the card. Because formatting also 

deletes protected images, you should check the data recorded on the card carefully 

before proceeding.

The battery level of the camera 

is indicated by [  ] or 

[  ]. When you are using 
the AC Adapter Kit (optional) or 

DC Coupler, [  ] is displayed.

This box shows whether a 
memory card is loaded in the 
camera along with the 
available space on the card 
and its total capacity.
You can also initialize the 
memory card by clicking the 
[Format] button.

Applies the settings that you have specified to the camera 
and closes the [Camera settings] dialog box.

Enter the name of a camera 
owner. You can enter up to 
31 characters.

Enter a value or click the [�]/
[�] buttons to specify the date 
and time.

Imports the date and time 
from your computer.

This box shows the camera 
model, body ID (serial 
number) and firmware 
version.

Restores the parameters to their original ones 
and closes the [Camera settings] dialog box.

Enter the name of a camera 
owner. You can enter up to 
31 characters.
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Merging Images with the PhotoStitch
You can merge multiple JPEG images to create a panorama shot.

1 Double-click the [Canon Utilities] folder � the [PhotoStitch] folder 

� the [PhotoStitch Launcher] icon.

 [PhotoStitch Launcher] appears.

2 Click the [Merge Images] button.

 The PhotoStitch starts up.

 Follow the instructions in the guidance window to merge the images.

 Refer to the PhotoStitch Help menu for more details.

 You cannot merge RAW images in the PhotoStitch.

 Up to four images can be merged using the PhotoStitch.
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Remote Shooting in 

the EOS Capture

This chapter describes how to use the EOS Capture for taking shots and 

specifying the camera settings remotely from your computer.

For more information on the restrictions of the EOS Capture, refer also to the source 

listed below.

Readme: Double-click the [Canon Utilities] folder � the [EOS Capture] folder �

[ReadMe].

 Remote shooting in the EOS Capture is only available with the EOS 20D.

 The EOS Capture is only compatible with OS X.

Starting the EOS Capture.......................................................................M-54

Remote Shooting ....................................................................................M-56

Single-frame Shooting .........................................................................M-56

Timer Shooting ....................................................................................M-57

Interval Timer Shooting .......................................................................M-58

Specifying the Camera Settings............................................................M-59

Camera Settings..................................................................................M-59

White Balance Adjustment ..................................................................M-61

Specifying the Save Destination..........................................................M-62
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Starting the EOS Capture
 Remote shooting in the EOS Capture is only available with the EOS 20D.

 The EOS Capture is only compatible with OS X.

1 Connect the camera to your computer (M-9).

2 Start up the EOS Viewer Utility (M-14).

3 Select the folder to save the 

image in. 

 Select a folder in the Tree View 

Area to save the image in, or 

create a new folder (M-18). (The 

[Capture] folder is created here as 

an example.)

4 Click the [EOS Capture] button.

 The EOS Capture main window 

appears.
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 If you quit the EOS Capture, select the [EOS Capture] menu � [Quit EOS Capture].

EOS Capture main window

5 Click the [Release] button to take a shot (M-56).

The EOS Capture operates in conjunction with the EOS Viewer Utility. Therefore, when 

you quit the EOS Viewer Utility, the EOS Capture also quits.

Allows you to check and 
specify the camera 
settings (M-59).

Release button (M-56)

 button (M-61)

Shows/hides the white 
balance adjustment 
dialog box.

Status

Displays the status while 
specifying the settings.

Rotate button

The image is downloaded, 
rotating 90 degrees each 
time you click the button, 
regardless of the vertical or 
horizontal position of the 
camera.
* To use the rotation 

function, click [On] 
checkbox in [Save 
settings] dialog box (M-62).
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Remote Shooting
You can control the camera from your computer and take single-frame shots, timer shots and 

interval timer shots. The images are automatically saved on your computer.

1 Set the camera up ready to shoot.

2 Make various settings.

 See “Camera Settings” (M-59) and “White Balance Adjustment” (M-61) for 

information on how to specify the camera settings.

 See “Specifying the Save Destination” (M-62) for information on how to specify the 

settings for saving images.

3 Click the [Release] button.

 The shot images are displayed in 

the EOS Viewer Utility and saved 

in your computer automatically.

Before you use the Remote Shooting function, be sure to check that the camera is ready 

for shooting. If the camera is not ready for shooting (the lens is not attached, etc.), you 

cannot perform the operation as explained.

Alternatively, you can press the space bar to shoot.

Single-frame Shooting
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Approximate Transfer Time for Shooting RAW Images

• The transfer time given here is only an approximation. Actual transfer time varies 

widely depending on the images and the computer system.

• The time for images shot in JPEG format will be shorter than those shown above.

• Transfer time is based on Canon testing standards.

(Time until images appear in the EOS Viewer Utility main window after you uncheck the 

[Save also on the camera’s memory card] checkbox and click the [Release] button in the 

EOS Capture main window using the following: OS: OS X 10.2; CPU: Power PC G5 1.6 

GHz; RAM: 256 MB)

EOS 20D Approx. 5 seconds

When the camera is set to One Shot AF, you cannot take shots if the camera cannot focus. 

If you cannot take shots with the auto focusing, focus manually and then take a shot.

The number of available shots changes depending on the available capacity on your 

computer’s hard disk. You can check the number of available shots with the [Shots to 

Go] (M-59).

1 Select the [Tool] menu � [Timer shooting].

 The [Timer shooting settings] dialog box appears.

2 Enter a delay time and click the [Start] button.

 You can set a value between 0 

seconds and 99 minutes 59 

seconds in 1-second increments.

 Timer shooting shots are taken.

Timer Shooting
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1 Select the [Tool] menu � [Timer shooting].

 The [Timer shooting settings] dialog box appears.

2 Click the [Interval timer shooting] checkbox.

3 Enter the shooting interval and the number of shots. Then click 

the [Start] button.

 You can set a shooting interval 

between 5 seconds and 99 

minutes 59 seconds in 1-second 

increments.

 You can set up to a maximum of 

1999 shots.

 Interval timer shooting is 

performed using the specified 

interval between shots and the 

specified number of shots.

On some types of computers, if you set a short interval between shots and there is 

insufficient time to download and save the images, it may not be possible to take shots at 

the specified interval. If this occurs, set a longer interval between shots and take the 

shots again.

Interval Timer Shooting



M-59

M

4

R
e

m
o

te
 S

h
o

o
ti
n

g
 i
n

 t
h

e
 E

O
S

 C
a

p
tu

re

Specifying the Camera Settings
You can check and change the settings in the camera from your computer remotely.

You can check and specify the camera settings.

1 Check the camera settings.

‘

* The above window shows all the information at once. In actual use, only the 

information needed is displayed.

Camera Settings

Shooting mode

Displays the shooting mode.

White Balance

Displays/specifies the 
white balance.

Exposure compensation

Displays/specifies the exposure 
compensation value.

Image recording quality

Displays/specifies the image 
recording quality.

ISO Speed

Displays/specifies the ISO speed.

Aperture value

Displays/specifies Av (aperture value).
(Not displayed when Shutter-priority AE or 
Program AE is specified for the shooting mode)

Shutter speed

Displays/specifies Tv (shutter speed).
(Not displayed when Aperture-priority AE or Program 
AE is specified for the shooting mode)

Save destination display
Displays the destination folder to 
which images will be saved.
(When you click the [Save also 
on the camera’s memory card] 
checkbox, the camera/PC icon is 
displayed, and when you 
uncheck the checkbox, the PC 
icon is displayed.)

Color temp.

Specify the color temperature in a range 
of 2800K to 10000K.

Metering mode

Displays/specifies the 
settings of the metering 
mode.

Bracket shots

Displayed when any of 
WBB/AEB/FEB is 
specified.

AF mode

Displays the AF mode.

Drive mode

Displays the drive mode.

Warning display

Displayed when the remote shooting is impossible due 
to inappropriate settings.

Battery status

When you are using a battery, 
[  ] is displayed. When you 
are using the AC Adapter Kit 

(optional) or DC Coupler Kit, [  ] 

is displayed.

Shots to Go
Displays the number of available 
shots.
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2 Click the icon.

 The icon displayed here shows 

exposure compensation as an 

example.

3 Use the button to change a value.

 The changed settings are applied to the camera.

 Before you specify the settings, be sure to check that the camera is ready for 

shooting. If the camera is not ready for shooting (the lens is not attached, etc.), you 

cannot make some of the settings.

 Set functions which you cannot set with EOS Capture (drive mode, AF mode etc.) in 

the camera.

1-step down settings button

Allows you to decrease the value by 1 step.

Minimum settings button

Specifies the minimum value.

1-step up settings button

Allows you to increase the value by 1 step.

Maximum settings button

Specifies the maximum value.
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You can compensate white balance with the blue/amber/green/magenta digital filter.

 If the dialog box has not appeared, click the [�] button.

Click the compensation position.

 The changed settings are applied to the camera.

White Balance Adjustment

Compensate magenta.

Compensate green.

Compensate blue. Compensate amber.

Displays the 
compensation value.
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You can specify save destination files and file names.

1 Select the [File] menu ���� [Save destination setting].

 The [Save settings] dialog box appears.

2 Specify desired settings and click the [OK] button.

Save settings dialog box

Specifying the Save Destination

Allows you to change the destination folder to which images 
will be saved. The name of the destination folder is displayed 
next to the [Browse] button.

Applies the settings and closes the [Save settings] 
dialog box.

Cancels all the settings, and restores the settings to 
their original ones.

Clicking the checkbox also saves images 
on the memory card in the camera.

Use this field to enter a file name when 
saving an image. The file name can 
consist of up to 18 characters.

Enter a sequential number with a range of 
0000 to 9999 that is added to the end of 
the file name.

Click the checkbox to enable use of the rotation function (M-55).
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Troubleshooting and

Uninstallation

This chapter provides troubleshooting and describes the software 

uninstallation procedures.

Troubleshooting .....................................................................................M-64

Uninstalling the Software.......................................................................M-66

Index ........................................................................................................M-67
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Troubleshooting
When the “Communication between the camera and computer failed” or “Software not running 

correctly” message appears, check the items described below.

 Does your computer comply with these requirements?

� A Macintosh with a USB connector as a standard feature.

* Operation is not guaranteed when the camera is connected to an interface that is not a 

standard feature of Macintosh.

 Are the camera and computer connected correctly?

� Connect the camera to your computer correctly using the dedicated cable (M-9).

 Is the correct communication mode selected on the camera?

� When using the EOS 20D, EOS 10D and EOS DIGITAL REBEL/300D DIGITAL, set the 

camera’s communication mode to [Normal] (M-8). With the EOS 10D, you must also 

change the firmware to version 2.0.0 or later. For details on changing, see the Canon 

website.

 Is there sufficient charge left in the camera battery?

� Your computer does not supply power to the camera. With the EOS 20D, EOS 10D and 

EOS DIGITAL REBEL/300D DIGITAL, connect to the camera with an AC Adapter Kit 

(optional). With the EOS D60 and EOS D30, connect to the camera with the DC Coupler 

supplied. Or, load a fully charged battery into the camera before connecting it to your 

computer.

 Do you have more than one camera connected to your computer?

If you connect more than one camera to the same computer, the driver and camera may not 

operate normally.

� Quit the software and disconnect all the dedicated cables. Then connect only one 

camera to the same computer again.

 Are you using a first-generation iMac without having updated the firmware? 

Update the firmware using the iMac Firmware Update.

� Download the iMac Firmware Update from the Apple website.

I have installed the software but the camera and 
computer cannot communicate.
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 Is the preferences file for the software corrupted?

� The preferences file for your software may be damaged.

Quit all active programs, delete the [Canon CameraCom Pref] file and the preference 

files for the software you are using from the [Preferences] folder, and then restart the 

software.

For OS X, double-click the startup disk � click the [Home] button � double-click the 

[Library] folder � [Preferences] to open the [Preferences] folder and delete the target 

preference files.

For OS 9, double-click the startup disk � the [System Folder] � the [Preferences] folder 

to open the [Preferences] folder and then delete the target preference files.

• EOS CameraCom Pref Preferences file shared by all software programs for 

communications (OS X only)

• CanonEOSViewerUtility Pref Preferences file for the EOS Viewer Utility

• EOS Viewer Utility.plist

• com.canon.EOS Capture.plist Preferences file for the EOS Capture (OS X only)

• PhotoStitch Pref Preferences file for the PhotoStitch

The software doesn’t run properly or doesn’t run at all.
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Uninstalling the Software
The following explanation uses the procedures for uninstalling the EOS Viewer Utility as an 

example for uninstalling other programs as well.

 The software uninstallation procedure is the same for both OS X and OS 9.

 Before beginning the software uninstallation, quit all programs you are using and disconnect 

the dedicated cable from your computer.

 When you have moved the folders and the software to be deleted to the Trash, select 

[Empty Trash] from the [Finder] menu (For OS 9, select [Empty Trash] from the [Special] 

menu.) and empty the Trash. You cannot reinstall the software until you have emptied the 

Trash.

1 Display the folder in which the software is saved.

 Open the [Canon Utilities] folder.

2 Drag the folder for the software to be uninstalled to the Trash.

3 Select the [Finder] menu on the desktop � [Empty Trash].

 For OS 9, select the [Special] menu � [Empty Trash].

 The software is deleted.

 When uninstallation ends, restart your computer.

You cannot retrieve data which you have moved to the Trash and deleted. Be particularly 

careful when deleting data.
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